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Overview 
The Tracker is a PrintSmith module designed for shop floor data collection for customers 
looking for true costing of time and materials on all jobs. The Tracker module offers the 
following features: 

Comprehensive Real-Time Production Tracking 
• The Tracker module records actual time spent on all job functions relating to 

production by allowing employees to log a start and stop time for each process.  

• In order to accommodate real life, each step can be paused if necessary and 
restarted at the point left off.  

• Time is tracked for each step, including setup time and washup time, as well as the 
process as a whole.  

• Estimated to actual time can be compared upon completion of the particular process.  

• Real-time job ticket and paper cutting diagram previews. 

• Job costing information is automatically updated on the invoice, eliminating the need 
for manual entries. 

• Managers have an overview of all employees and their active processes. Managers 
also have an up to date view of all processes of all jobs and their completion status. 
Employees can view the processes and completion status of their own jobs.  

• Tracked production data can be reported on using Report Writer. 

Easy and Highly Customizable Setup 
• Production routes can be defined to simplify the order entry process by 

predetermining the steps involved in the process.  

• Production dates can be set for all functions of the production process and adjusted 
individually or grouped. These dates can be automatically generated by the system or 
manually entered. 

• There is a release to production inhibiting someone from accidentally changing a job 
already in process. 

• Filters can be defined for each employee. These filters allow you to determine what 
processes are applicable to individual employees and only display that relevant 
information to the employee. Tracking is available using shared workstations by 
multiple employees and across multiple facilities. 

• Bar code compatible. Selection may be entered using bar code readers at various 
stations using bar code readers and special job ticket routing reports. 

Notes:  The PrintSmith Tracker module is not compatible with offline barcode readers 
such as the Palm Symbol. 
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Setting Up the Tracker Module 
There are a few basic steps to get the Tracker module working with the PrintSmith 
application. 

 

Basic setup includes: 

• Activating the Tracker module in Preferences 

• Updating the new tables with information specific to your facility 

• Defining Tracker information for Press Definitions, Copier/Digital Definitions, and 
Charge Definitions 

• Setting up Employees with Production Filter information 

 

Additional setup to fully utilize all features of the Tracker module includes: 

• Setting up Costing Information 

• Defining Routings in the Tracker Manager 

A phased approach to implementing the Tracker module is recommended. With the basic 
setup completed, you can start using the Tracker module and familiarize yourself with its 
features. As you become more comfortable with the features and workflow functionality of 
the Tracker module, you can set up the advanced features and take advantage of the full 
functionality of the Tracker module. 

Notes:  Costing Information and Routings do not have to be set up to utilize the Tracker 
module. Implementation of these features can occur at a later time. 
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Activating the Tracker Module 
To activate the Tracker module: 

1. Select Admin > Preferences from the menu. The Preferences window opens. 

2. Select System > Product Activation from the Pref List. Product Activation options 
are listed in the Preferences window. 

3. Enter the activation code supplied by PrintSmith in the Tracker data collection field. 

Tracker Module Activation in Preferences window 

 

Tracker 
Module 
Activation 
Field 

 

4. Click OK to save changes. 

5. Click the Close button. If a valid activation code has been entered, the Tracker menu 
items and functionality are available within PrintSmith.  
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PrintSmith Tables 
Several PrintSmith tables accommodate the Tracker module: Production Copiers, 
Production Exceptions, Production Facilities, Production Locations, Production Presses, 
Production Priority, and Production Stations. Access and edit these tables using Admin > 
Table Editor. 

Production Copiers 

The Production Copiers table supports the Machine Name field in the Copier/Digital 
Definitions window. Copier names should be entered as the actual hardware names that 
identify your equipment. For example: Docutech, Canon CLC 5000. Copier names are 
also used in the Employee Production Filter to determine which jobs will be seen in the 
Tracker Console. 

Production Exceptions 

The Production Exception table supports the Exception code field in the Stop Tracker Step 
window. Exception codes are customizable to your facility and should be used as standard 
exception reasons, for example: static in paper, bad plate. The addition of this table and 
field allows for a quick and uniform way to gather information from production personnel 
without requiring a hand-typed note. 

Production Facilities 

The default Production Facility has been set as In House. The Production Facility is the 
physical location/building where production machinery is run and operated. You can edit 
the name of the Production Facility to better accommodate your internal referencing. If all 
of your jobs are processed within one building, there is no need to add additional 
Production Facilities. 

Production Locations 

A Production Location is the name of a process that indicates what stage a job is at in the 
overall production process. Production Locations can be customized based on your 
internal referencing system. For example, when a job is in the printing stage, you could 
call that Production Location Press, On Press, In Printing. For a copy job, when the job is 
actually being copied you could set the Production Location as Copy, Being Copied, In 
Copying.  

Production Presses 

The Production Presses table supports the Machine Name field in the Press Definitions 
window. Press names should be entered as the actual hardware names by which you 
refer to your equipment. For example: Komori or Heidelberg. Press names are also used 
in the Employee Production Filter to determine which jobs will be seen in the Tracker 
Console. 
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Production Priority 

A Production Priority is set based on your internal language and referencing system for 
indicating which jobs should take precedence. Example Production Priority levels are: 
Normal, Priority 1, Priority 2, Red, Blue, Yellow. Production Priorities are defined in the 
Table Editor and can be assigned to a job in the Tracker Production window. 

Production Stations 

A Production Station is the computer terminal where PrintSmith is running. These 
Production Stations or computer terminals should be given logical names based on your 
internal referencing so that you know where the data collection is occurring and so that 
filters can be applied to only display jobs that are in the vicinity of the workstation.  
Example Production Station names are Press Station One, Supervisor Station, Folding 
Station, and Shipping Station. 

PrintSmith Fields 
Several PrintSmith fields accommodate the Tracker module functionality. 

Location/Production Location 

A Production Location is the name of a process set to indicate what stage a job is at in the 
overall production process. Production Locations are defined in the Production Locations 
table. Production Location or Location fields appear in several PrintSmith application 
windows to support the Tracker module. When Production Locations have been defined in 
the Production Locations table, it is possible to select the Production Locations from a 
drop-down menu in the following PrintSmith application windows: Copier/Digital 
Definitions, Charge Definitions, Press Definitions, Job, Tracker Production, Tracker 
Console, Tracker Manager, and Employees. 

Facility 

A Facility is the physical location/building where production machinery is run and 
operated. Facilities are defined in the Production Facilities table. Facility fields appear in 
several PrintSmith applications windows to support the Tracker module: the Tracker 
Console, the Tracker Manager, and Tracker Production. 

Station 

A Station is the computer terminal running the PrintSmith application. Stations are defined 
in the Production Stations table. Station fields appear in several PrintSmith application 
windows to support the Tracker module: the Tracker Console, the Tracker Manager, and 
Tracker Production. 

Machine Name 

A Machine Name is the actual hardware name for the Presses and Copiers in your facility. 
Machine Names are defined in the Production Presses and Production Copiers tables. 
Machine Name fields appear in several PrintSmith application windows including: 
Copier/Digital Definitions, Press Definitions, Tracker Console, Tracker Manager, Job 
Ticket, and Employees. 
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Defining Tracker Information for Press Definitions 
1. On the Pricing menu, click Press Definitions. The Press Definitions window opens. 

2. Select the applicable press from the list to see its information. 

Setting Press Definitions 

 

The Machine 
Name is defined 

in the 
Production 

Presses table. 

The 
Production 
Location is 
a stage in 

the 
production 

process 

The 
Washup 
Minutes 
field 
supports 
Tracker  

3. Select the Production Location, for example, On Press, Printing, and In Printing. 

4. Enter the Washup Minutes. 

5. Enter a Machine Name. The Machine Name enhances workflow capabilities within 
Tracker. Previously you may have referenced a press by its Machine ID number, but 
the Machine Name will make it quicker and easier for all employees to recognize what 
machine is being referred to in the Tracker Console. The Machine Name is displayed 
in the Time graph of the Tracker Console and in the Job Ticket. The Machine Name 
also supports the Work in Progress report, allowing you to sort information by 
Machine Name. Example Machine Names: Komori, 4-Color Press. 

6. Repeat steps 3 – 5 for all Presses. Save changes and Close Press Definitions. 

Notes:  The Machine Name does not have to be entered for the Tracker module to 
function, but it will enable you to take full advantage of the Tracker capabilities. 
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Defining Tracker Information for Copier/Digital 
Definitions 
1. On the Pricing menu, click Copier/Digital Definitions to open the Copier/Digital 

Definitions window. 

2. Select the applicable copier from the list. The copier’s information is displayed. 

Setting Copier/Digital Definitions 

 

The Machine 
Name is 

defined in the 
Production 

Copiers table. 

 

3. Select the Production Location, for example, Copying, In Copying, Replication. 

4. Enter the Machine Name for the copier. The Machine Name enhances workflow 
capabilities within the Tracker module. Previously you may have referenced a copier 
by its ID number, but the Machine Name makes easier for all employees to recognize 
which machine is referred to in the Tracker Console. The Machine Name is displayed 
in the Time graph of the Tracker Console and in the Job Ticket. The Machine Name 
also supports the Work in Progress report, allowing you to sort information by 
Machine Name. Example Copier Machine Names: Docutech, Canon CLC 5000. 

5. Repeat steps 3 – 4 for all Copiers. Save changes and Close the window. 

Notes:  The Machine Name does not have to be entered for the Tracker module to 
function, but it will enable you to take full advantage of the Tracker capabilities. 

The Production 
Location is a 
stage in the 
production 
process. 
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Defining Tracker Information for Charge Definitions 
Costing information defined for a charge is associated with the Tracker module. Individual 
charge definitions can be excluded from the Tracker module, and will not be displayed in 
any of the Tracker module screens. To exclude a charge, select Exclude From 
Production. 

1. On the Pricing menu, click Charge Definitions. The Charge Definitions window 
opens. 

2. Select the applicable charge from the list to display its information. 

3. Select a Production Location for the charge. 

4. Individual charge definitions can be excluded from the Tracker module, meaning they 
will not be displayed in any of the Tracker module screens. To not include a charge, 
with a charge selected from the list in the Charge Definitions window, place a check 
in the box next to the Excluded from production option. 

 

Setting Charge Definitions 

 

The 
Production 
location is a 
stage in the 
production 
process. 

Set this 
option if the 
selected 
charge 
should not be 
displayed in 
the Tracker 
module. 

Select to 
allow work to 
be done on 
invoice 
before 
releasing job 
to production 
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Setting Up Estimated Costs for the Tracker Module 
The ability to set up costs for each individual charge in the Charge Definitions window 
allows the Tracker module to create estimated costs which can then be compared to 
actual costs. For more information on setting up costing, please refer to Chapter 6 Pricing 
in the Reference Guide. 

Setting Costing Information in the Charge Definitions Window 

 

Click here 
to create a 
Cost 
Estimate 
for the 
selected 
process. These 

processes 
have 

Costing 
Information / 

Estimates 
defined. 

Processes 
with the “$” 

symbol 
crossed-out 
do not have 

Costing 
Information. 

 

Creating a Cost Estimate 
1. Select the process in the left pane of the Charge Definitions window that needs to 

have a cost estimate created. 

2. Click the Costing  Icon in the top right corner of the Charge Definitions window. 

3. The Costing Information window opens. 
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4. Select the Costing Method from the drop-down menu. Possible Costing Methods are: 

No Cost, 100% Cost, Unit Cost, and Time and Materials. 

Costing Information Window 

 

Select a Costing 
Method from the drop-
down menu. By default, 
processes that do not 
have cost estimates 
defined are set to No 
Cost. 

 

Notes:  Time and Materials Costing must be set up if you want the ability to compare 
Estimated Time to Actual Time using the Tracker module. 

Costing Method – No Cost 

Processes that do not incur a cost, such as a markup, should have the Costing Method 
set to No Cost. Processes with the No Cost setting will not be included in the cost 
estimates in the Tracker module. 

Costing Method – 100% Cost 

Processes that should have 100% of the cost charged back to the customer, such as 
postage or shipping, should have the Costing Method set to 100% Cost. When the 100% 
Cost Costing Method is selected, the entire cost of the process will be included in the cost 
estimates in the Tracker module. 
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Costing Method – Unit Cost 

Items with costs, such as ink, that are best defined by unit should have the Unit Cost 
Costing Method selected. When the Unit Cost Costing Method is selected, you can enter a 
Setup Cost, Unit Cost, and select a Rate from the Price List.   

 

           Selecting Unit Cost Costing Method 

 

Enter values for the 
Setup Cost and Unit 
Cost of the Process. Click the Rate button to 

assign a table with pre-
defined costing 

information.

 

1. Enter a value for the Setup Cost. 

2. Enter a value for the Unit Cost. 

3. Click the Rate button to either assign a previously created Price List or create a new 
Price List to assign to the Costing Method. 
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Costing Method – Time and Materials 
Processes, such as making plates or folding a job, that require labor should have the Time 
and Material Costing Method selected. When the Time and Material Costing Method is 
selected, you can enter Fixed Materials, Unit Materials, Labor Rate, Setup (minutes), 
Pieces/Hour, and select a Speed Table. Using the Time and Materials Costing Method 
allows you to compare Estimated and Actual Times in the Tracker module. 

Selecting Time and Materials Costing Method 

 

Enter values for Fixed 
Materials, Unit 
Materials, Labor Rate, 
Setup time, and 
Pieces/Hour. 

Click the Speed 
button to assign a 
Speed Table with 
pre-defined time 

information.

1. Enter a value for Fixed Materials. 

2. Enter a value for Unit Materials. 

3. Enter a Labor Rate.  

4. Enter a time for Setup (minutes). This is the amount of time in minutes that it takes 
to set up the process. 

5. Enter a value for Pieces/Hour. Pieces/Hour is an estimate of how many pieces can 
be processed within one hour. 

6. Click the Speed button to open a listing of speed tables and either assign a 
previously created Speed Table or create a new Speed Table to assign to the Costing 
Method. 
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View Collected Invoice Costing Information 
Data Collections information is displayed in pink in the Invoice Costing window. The 
costing information displayed by Data Collections is cumulative and comes from 
information gathered with implementation of the Tracker module and Time and Materials 
cost settings. 

To view the new Data Collections costing information: 

1. Open an Invoice and click the Costing  icon. 

2. The Invoice Costing window opens. The Actual Cost information collected by using 
the Tracker module is displayed in pink. You can compare the Actual Cost to 
Estimated Cost, view the monetary and percentage Difference, the Price and the 
profit Margin. 

• Actual Cost – Actual cost of Labor Time added to Material Costs 

• Difference – The monetary and percentage difference between Estimated 
and Actual Time and Material Costs. 

• Price – The Stock and Labor values with Markup added to the Production 
value as set in the Production Data window. 

• Margin – The monetary and percentage Margin of profit calculated from the 
Actual Time and Materials Cost and the set Price.  

Invoice Costing window with Data Collections 

 

Data 
Collection 
Information 
is displayed 
in pink. 
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Employee Manager 
The Employee Manager provides access to the following functions:  

• Clock In/Out – This feature allows the recording of real employee time.  Only 
employees who are clocked in can use the Tracker Console. 

• Employees – The Employees window, which existed in version 7.1, is now accessed 
from within the Employee Manager window.  The functionality has not changed. 

• Clock Options – Allows settings for individual employees to be set, including Status, 
Auto Out time, and a message to be displayed at clock in/out.  Managers can see at a 
glance which employees are in, out, or on break. 

• Time periods – Controls the grouping of employee time periods, with weekly, monthly 
and custom options. 

• Edit time cards – View and modify all employee time cards from this convenient 
console. 

• Reports – Create and customize employee time reports. 

• Exports – Export employee time information for import into a payroll system. 

To open the Employee Manager, select Admin > Employee Manager. 
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Clock In/Out 
Individual employees can clock in and out and also record break time using the Clock 
In/Out feature of the Employee Manager.  Managers can see at a glance which 
employees are in, out, or on break.   Only employees who are clocked in can use the 
Tracker Console. 

Note:   Disabled employees will not appear in the Clock In/Out window. 
To record work time: 

1. Select Admin > Employee Manager from the main menu.  The Employee Manager 
opens. 

2. Click the Clock In/Out button.  The time recording window opens. 

3. Select the employee name in the table at the bottom of the window. 

4. Click the Clock In, Clock Out, or On Break button.  Only the options that are 
available for the highlighted employee can be selected.  The employee will appear in 
the column that reflects their current status – Out, In, or Break. 

 
 

Employees are displayed in the 
column that reflects their 
current status – Out, In, or 
Break 
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Employees 
To open the Employee window, select Admin > Employee Manager > Employees. 

 

Functionality Toolbar 
This toolbar lets you perform common functions with the mouse. The File and Print icons 
have equivalent menu commands and are subject to the same security as the menu 
commands. The buttons are grayed out when the menu command is not available. 

Employee Window Functionality Toolbar 

 

Last 

The Last icon takes you to the previous Employee record. Employee records are sorted 
alphabetically by Last Name. 

Next 

The Next icon takes you to the next Employee record. Employee records are sorted 
alphabetically by Last Name. 

Save 

The Save icon saves the employee record and keeps the record open. 

File 

The File icon saves the employee record in the PrintSmith database and closes the 
Employee window. 

Get 

The Get icon opens the Employee List from which you can select an employee record to 
view or edit. 

New 

Click the New icon to create a new employee record. You can also create a new 
employee record by selecting Admin > Employees and clicking Cancel when the list of 
employees is displayed. 

Delete 

Click the Delete icon to delete an employee record. 

Print 

The Print command is equivalent to selecting Print from the File menu. It is used when you 
want to generate a hard copy of the document. Before a document is printed, it is first 
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filed. Currently, PrintSmith prints these values in the supplied Employee Barcode report: 
the employee's name, the PrintSmith employee ID number, the employee's status if the 
employee is currently inactive, and the barcode representation of the PrintSmith employee 
ID number. When printing the Employee Barcode report, you can print each one 
individually by selecting Pages 1-1 setting in the Print window. To print all employees, 
select the All pages setting.  

Cancel 

Click Cancel to undo any changes made to the employee record since it was last saved. 
The Employee window will remain open with the current employee record still active. 

Close 

Click the Close icon to close the Employee window. If any changes have been made to 
the employee record while it was open you will be prompted to save the changes. 

Adding New Employees 
The Production Tracker module requires that employees be defined. This information is 
needed in order to assign production jobs to specific employees and allow the employee 
to enter the step status information that is tracked. Special settings define what level of 
ability an employee has to view and change jobs. 

Each employee that is added to the PrintSmith system will be assigned a PrintSmith ID 
number. When you print your employees from the Employee window, you will also get a 
barcode that represents each employee's PrintSmith ID number. For extra convenience, 
you may wish to affix the barcode to an employee's badge or a laminated sheet of paper 
next to the Tracker Console workstation in your shop for easy barcode scanning that 
allows employees to select their jobs in the Tracker Console. 

To add new employees: 

1. Select Admin > Employees from the menu. A list of employees is displayed. 

2. Click the Cancel button. The Employee window appears. If you are already in the 
Employee window, you can add a new employee record by clicking the New icon. 

3. Click the Settings tab, if not already selected. 

Select Employees from the Admin Menu 

 

Select Employees 
from the Admin menu 
to open the 
Employee window. 
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Entering Settings in the Employee Window 
The Settings tab of the Employee Window allows you to enter general information about 
the employee including: First name, Last name, Address, Phone number, Mobile number, 
and Email address. For the Tracker module to function properly, it is only necessary to 
enter the First and Last name. The other fields are optional and for your reference 
purposes only. Once an employee record is created and saved, a unique ID number will 
be assigned to the employee. 

1. Settings Tab of the Employee Window 

   

An ID Number will 
be assigned to 
the employee 

once the record is 
saved.

Click the New 
icon to create 
a new 
Employee 
record once 
the Employee 
window is 
open. 

Only the First and 
Last name fields 

need to be 
populated for 

Tracker 
functionality.  

The additional 
information fields 

have been 
provided for your 

convenience.

Enter the setting information for the employee: 

1. Enter the First name of the employee. 

2. Enter the Last name of the employee. 

3. Enter address information in the Street, City, State, Zip, and Country fields. 

4. Enter a Phone number. 

5. Enter a Mobile phone number. 

6. Enter an Email address. 

7. Once all information has been entered on the Settings tab, you can go to the  
File > Save main menu option to Save the information, or save the information once 
entry has been completed on all tabs. Clicking the File icon in the Employees window 
will save and close the window. 

Notes:  Only the First and Last name of the employee need to be entered for the 
Tracker module to function. All other information is available for your own 
reference purposes. 

 
Page 23 



EFI PrintSmith 8.0 │ Tracker Module Instructions 

 

Entering Personal Information in the Employee Window 
The Personal tab of the Employee Window allows you to define several security settings 
for each employee, as well as including information relevant to the Human Relations 
department and Accounting functions for your shop. 

Personal tab of the Employee window 

 

The Rate 
only needs to 
be set if it will 
be used in 

Enter personal information for the employee: 

1. Enter an hourly Rate. This value is the Employee’s hourly wage and only needs to be 
set if you wish to use it in conjunction with the Report Writer. 

2. Status: Verify the employee’s Status is set to Active. By default all newly added 
employees are Active. If the employee status is Inactive, the employee is not 
available within the Production Tracker. When employees take a leave of absence or 
are on vacation, you may wish to mark them as Inactive to prevent their name from 
showing up in the list of employees available to work with jobs. If other methods of 
security aren’t utilized, this can help narrow the choices of who might have been 
working on a job if the wrong employee was selected in the Tracker Console. 

3. Editable Production Options: 
a. Allowed to override costs - If the employee has a supervisory role and is 

allowed to make changes to the production cost calculations once a job is 
complete, place a check in the box next to Allowed to override costs. With 
this option selected, the employee will be able to change the values in the 
Setup, Run time, and Washup fields in the Stop Tracker Step Window. 

Only 
employees 

with an Active 
Status will be 
available for 
selection in 
the Tracker 

module.

Check this 
box to 
require an 
employee to 
enter a PIN 
to access the 
TrackerUse the 

Editable 
Production 
Options to 

limit 
employees’ 

ability to view 
or change 

cost, time, or 
production 

information. 

Use card reader 
technology for 
secure Tracker 
Console login in 
place of PIN 
settings. 
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b. Hide costing amounts - If for reason of privacy, accounting, or company 

policy, you do not want the Employee to see costs related to labor and stock 
utilization for a job, place a check in the box next to Hide costing amounts. 
Enabling this option will affect the display of these fields in the Stop Tracker 
Step window and the Tracker Details window: Estimated Stock Cost, 
Estimated Labor Cost, Estimated Cost, and Actual Cost. 

c. Hide items not released to production – If an employee should only see 
jobs that have been released to production, select this option. 

d. Hide estimated time in Tracker Console – If the employee should not see 
Estimated Time values in the Tracker Console or the Tracker Details 
window, select this option. 

e. Allow to modify production settings – If the employee should be able to 
modify production settings in the Tracker Production window, select this 
option. 

f. Allow Tracker NEXT location to be modified – If the 
employee should be able to modify the next production 
location through the Stop Tracker Step window, select 
this option.  Otherwise, the next location will be 
dictated by the assigned Routing Definition. 

g. Auto show Tracker Console at clock in – If the Tracker Console should 
open automatically when the employee clocks in, select this option. 

h. Auto show My Work Center at clock in  – If My Work Center, part of the 
PrintSmith Scheduling module should open automatically when the 
employee clocks in, select this option. 

4. PIN Settings. If the employee is required to enter a PIN (Personal Identification 
Number) prior to working in the Tracker Console, place a check in the box next to 
Require PIN. When the Require PIN box is checked, the PIN field becomes editable. 
Enter a PIN number between four and nine digits in length for the employee. For 
additional security the PIN will not be displayed as it is entered. 

5. Magnetic Card Reader Authentication. An alternate method of Tracker Console 
security is to select the Allow authentication with magnetic card option. When you 
select this option, you will be prompted to swipe the employee’s authentication 
magnetic card. After you swipe the employee’s card, click the Accept button. The 
card info is stored in an encrypted manner. With this option selected, the employee 
can securely login to the Tracker console without having a PIN set by simply swiping 
their magnetic card at their workstation. 

6. Once all information has been entered on the Personal tab, you can use to the File > 
Save main menu option to Save the information, or save the information once entry 
has been completed on all tabs. Clicking the File icon in the Employees window will 
save and close the window. 

7. Select the Production Filter tab to create a filter to further define the employee’s 
view in the Tracker Console. 
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Entering Production Filter Information in the Employee Window 
The Production Filter tab of the Employee window allows you to determine what jobs an 
employee will see when they select their employee profile in the Tracker Console Window. 
With the high volume of jobs that are processed in your facility, it is important to set these 
filters so that employees are quickly and easily able to find their jobs. An employees 
profile can be filtered by Invoices and Estimates, the Customer Wanted By date, 
Production Parents, Pricing Methods, Charge Types, Presses, and Copiers. 

Production Filter tab of the Employee window 

 

Filter by 
Customer 
wanted by 
date 

Filter to Inlcude 
Invoices or 

Estimates with 
Jobs, Job 

Charges, or 
Invoice level 

Charges 

Allow 
employees 
to see jobs 
in the 
production 
step before 
theirs. 

Filter so 
that only 
jobs of 
certain 
Charge 
Types 
show in the 
Tracker.

Filter which jobs 
to display in the 

Tracker based on 
Pricing Methods 

Filter so that 
pressmen will 

only see jobs for 
the presses they 

work on. 

For 
employees 
who work 
with copiers, 
only show the 
copiers they 
use.
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1. Check the types of items to Include: Invoices, Estimates, Jobs, Charges (assigned to 

Jobs), or Invoice level Charges.  

a. Invoices - If you place a check next to the Invoices option you are then able to 
select whether you want to include Jobs and/or Invoice level Charges. Nothing 
will display in the employee’s Tracker Console Active Items listing unless Jobs 
and/or Invoice level Charges are also selected. 

b. Invoice > Jobs – If you place a check next to the Invoices option and the Jobs 
option the employee will see each Job for an Invoice in the Active Items listing of 
the Tracker Console. Example: for invoice 1803 that includes jobs for Letterhead, 
Envelopes, and Business Cards, the jobs would be displayed in the Active Items 
listing of the Tracker Console as 1803/1 Letterhead, 1803/2 Envelopes, 1803/3 
Business Cards. 

c. Invoices > Jobs > Charges – If you place a check next to the Jobs option after 
the Invoices option is select, the Charges option is available for selection. If the 
Charges option is selected, the employee will see each job-level charge. 
Example: for the same invoice 1803, for job 1803/3 Business Cards, the 
employee might see 1803/3/1 Plates, 1803/3/2 Ink, 1803/3/3 Design, depending 
on other filter settings. 

d. Invoices > Invoice Level Charges – This option is only available once the 
Invoice option has been selected. If this option is selected, Invoice level charges 
will appear in the Active Items listing of the Tracker Console. 

Setting What to Include in the Production Filter 

 

 

Notes:  In general, you will only want to include Invoices and not Estimates for 
display in the Tracker Console. Estimates have only been included as a filter 
option to accommodate those users with an Estimator-only version of 
PrintSmith. For Estimator-only users, the same Include rules apply 
substituting Estimates for Invoices. 

2. Customer wanted by - Select which jobs the Employee will see based on the 
Customer wanted by date. Options include:  Due today, Due tomorrow, Due this 
week, Due next (7) days, Due anytime, and Any past due.  
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Setting the Customer wanted by date 

 

Only one Due date option can be 
selected in conjunction with past due 

items.  Here, the employee will only 
see those jobs due today, and those 

that are overdue.

Selecting the Due tomorrow option 
will also show the jobs that are Due 

today.

The Any past due option can 
be selected in conjunction with 
any of the other due dates.  
With this option selected, any 
jobs with a date before today’s 
date will be displayed in the 
Active Item listing for the 
employee. 

3. Check the Any past due option if those items should also be displayed to the 
employee. The Any past due option can be selected in conjunction with any of the 
other due date options. 

4. Production parents - Making a selection in the Production parents filter allows an 
employee to see the jobs that will be coming to them, i.e. that are in the step before 
theirs. For example, if an employee’s task is Press, selecting the Prepress option will 
display all Prepress jobs that will be coming to them in the Tracker Console.  

a. Production Parents options come from the Production Locations that are set up 
in the Production Locations table. Select the Only show checked Production 
Parents option to activate the Production Parents filter. 

b. To select a Production Parent for an employee, place the pointer in the column to 
the left of the Product parent and click the mouse. A black square will appear 
indicating that the item has been selected. More than one Production parent can 
be selected for the employee. 

c. In the Active Items listing in the Tracker Console, parent jobs are displayed in 
blue. 

Setting Production parents 

 

Production parents are set in 
the Production Locations table 
and customizable based on 
your facility. 

Selecting a Production 
parent for the employee 

will allow them to see 
the jobs that are 

queued in the 
production step before 

theirs.

Place a check in the box to 
have Production parents 

displayed in the employee’s 
Tracker Console view.
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5. Price Methods - In the Pricing Methods filter, select which pricing methods the 

employee should see. For example, a pressman would need to have the Printing 
Pricing Method selected in addition to all presses that he/she works on. Check the 
Use all Pricing Methods option if the employee should see all pricing methods. To 
select, place the pointer in the column to the left of the Pricing method and click the 
mouse. A black square will appear indicating that the item has been selected. More 
than one Pricing method can be selected for the employee. 

Setting Pricing Methods 

 

 

6. Charge Types - In the Charge Types filter, select which pricing methods the 
employee should see. Check the Use all Charge Types option if the employee 
should see all charge types. If an employee does not need to see Charge Types, no 
Charge Types need to be selected. To select, place the pointer in the column to the 
left of the Charge type and click the mouse. A black square will appear indicating that 
the item has been selected. More than one Charge type can be selected for the 
employee. 

Setting Charge Types 

 

 

Notes: Charge types are set in the Pricing > Charge Definitions window. 
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7. Press - In the Press filter, select which presses to display in the employee’s Tracker 

Console view. Checking the Use all Presses option will display all presses within 
your system to the employee. To select, place the pointer in the column to the left of 
the Press and click the mouse. A black square will appear indicating that the item has 
been selected. More than one Press can be selected for the employee. If an 
employee’s tasks or production parents have nothing to do with Presses, then no 
presses need to be selected for the employee. 

Setting Presses in the Production Filter 

 

Notes: Only presses that have been defined in the Production Presses table 
will be available for selection in the Production Filter. 

 

8. Copier - In the Copier filter, select which copiers to display in the employee’s Tracker 
Console view. Checking the Use all Copiers option will display all copiers within your 
system to the employee. To select, place the pointer in the column to the left of the 
Copier and click the mouse. A black square will appear indicating that the item has 
been selected. More than one Copier can be selected for the employee. If an 
employee’s tasks or production parents have nothing to do with Copiers, then no 
copiers need to be selected for the employee. 

Setting Copiers in the Production Filter 

 

 

Notes:  Only copiers that have been defined in the Production Copiers table will be 
available for selection in the Production Filter. 
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9. Save and Close - Once all Settings, Personal, and Production Filter information has 

been set for the employee, click the File icon to save and close the Employee 
window. It is also possible to save the Employee information by going to the main 
application File menu and selecting the Save option. This will save the newly entered 
employee data and leave the Employee window open. 
 

Production Filter Definitions 

Filter Name Definition 
  

Include The Include filter allows you to make a choice between Invoices or Estimates (for 
Estimator-only version users) and then drill-down to display jobs and job charges. 

Customer wanted by The date that the customer has designated for completion of the ordered job. 

Production parents A setting to allow the employee to see jobs in the step prior to theirs in the 
production process. 

Pricing Methods This filtering option will only display those jobs with Pricing Methods relevant to an 
employee’s work. If an employee works in Design, they may not need to see jobs 
with a Printing Pricing Method. 

Charge Types This filtering option will only display those jobs with Charge types relevant to an 
employee’s work.  

Press This filtering option allows you to display only those presses that the employee 
works with. This option would only be set for pressman or for an employee with a 
Press production parent. 

Copier This filtering option allows you to display only those copiers that the employee works 
with. If an employee does not work with copiers or have a copy job as a production 
parent, nothing needs to be selected here. 

 

Opening and Editing an Existing Employee Record  
It is possible to edit all information of an Employee record. Some information changes to 
the Employee record, such as address, will have no affect on Tracker functionality, but 
changes to Personal settings involving security and Production Filter options will modify 
an Employee’s ability to access the Tracker Console and the information that is viewable 
to them in the Tracker Console. 

An Employee record can be opened in two ways: 

1. Select Admin > Employees from the main application menu. 

a. A list of employees sorted alphabetically by last name appears. 

b. Highlight the name of the employee record you would like to open and click the 
Select button. The selected employee’s record will open. Make any necessary 
changes to the Settings, Personal, or Production Filter tabs. 

c. Click the File icon to save changes and close the employee record. 
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2. From within the Tracker Console, click within the Employee name field. 

a. A list of employees sorted alphabetically by last name appears. 

b. Double-click the name of the employee whose record you would like to open and 
click the People  icon to the right of the Employee name field. The selected 
employee’s record will open. Make any necessary changes to the Settings, 
Personal, or Production Filter tabs. 

c. Click the File icon to save changes and close the employee record. You are 
returned to the Tracker Console. Changes made in the Production Filter tab are 
immediately updated in the Active Items listing. 

Deleting Employee Records 
It is possible to permanently remove an employee record from the PrintSmith system, 
though it may not always be best practice for accounting purposes. To delete an 
employee record, select the Delete icon in the Employee window toolbar. Rather than 
deleting an employee due to termination or other reasons, it is possible to mark them as 
Inactive by selecting an option in the Personal tab of the Employee window. For more 
information on this, please review the section on Entering Personal Information in the 
Employee Window. It is not possible to delete an employee who has Active Items in the 
Tracker Console. 

Click the Delete  icon in the Employee window to permanently delete an employee 
record from the PrintSmith system. 
 

Clock Options 
The Clock Options window allows settings for individual employees to be set, including 
Status, Auto Out time, and a message to be displayed at clock in or out.  Managers can 
also use this window to see which employees are in, out, or on break. 

To modify clock options: 

1. Select Admin > Employee Manager from the PrintSmith menu.  The Employee 
Manager opens. 

2. Click the Clock Options button.  The Clock Options window opens. 

3. Select the employee name in the table at the bottom of the window. 

4. For the selected employee, the following options can be set: 

• Status:  Select Active or Inactive. 

• Auto Out:  Set an Hour and Minute time for the employee to automatically be 
clocked out. 

• Message:  Enter a message that will be displayed when an employee clocks in 
and/or out. 
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5. Click Save to save changes to the employee’s clock options, and click Revert to undo 

any changes. 

 
 

Set Auto Out 
time 

Enter 
Message for 
Clock In or 
Clock Out 

Clock Options set 
for selected 
employee
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Time periods 
The Employee Time Period controls how employee time cards are grouped.  Time periods 
can be custom defined, or can be set as weekly, bi-weekly, semi-monthly, or monthly.  
The current period displays the number of periods of the set type that have occurred since 
tracking has begun.  The date range of the time period is also displayed.   To begin a new 
time period, click the Close current period button. 

To set time period options: 

1. Select Admin > Employee Manager from the PrintSmith menu.  The Employee 
Manager opens. 

2. Click the Employee Time Period button.  The Employee Time Period window opens. 

3. Set the Period Type by selecting Weekly, Bi-Weekly, Semi Monthly, or Monthly 
options.  To set a Custom time period, enter a From and To date in mm/dd/yyyy 
format. 

4. Set the Start of Work Week by selecting a Day from the dropdown list. 

5. To save changes and close the window, click OK. 

 
 

Set Period Type 

Current Period 
information 
displays 

Close current 
period 

Select Start of 
Work Week Day 
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Edit time cards 
The Employee Time Cards window displays all employee time cards for the selected 
employee by the designated time period.  Changes can be made to the time cards and 
new time entries can be made. 

To modify employee time cards: 

1. Select Admin > Employee Manager from the PrintSmith menu.  The Employee 
Manager opens. 

2. Click the Edit time cards button.  The Employee Time Cards window opens. 

3. Select the employee name in the Employees column.  Time card information for the 
selected employee is displayed. 

 
 

Time card 
entries for 
selected 
employee 

Select time 
period 

4. Select the time period to display using the tabs at the bottom of the window.  Options 
are:  Active Period, Previous Period, All, and Specify Period.  If Specify Period is 
selected, enter the period number in the Specify Period field. 
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5. Select the time card entry to be modified.  Either double-click it, or click the Change 

button.  The individual time record opens. 

 
 

Billable Time 

 

Paid time off 
option 

6. Make changes to the In and Out date and time, Billable Time, or Break Time. 

7. Select the Paid time off option if applicable. 

8. Click Save to save changes and close the window. 

Note:   Time designated as Paid time off will not be counted against production 
totals. 

 

To delete time card entries: 

1. With the Employee Time Cards window open, select the time card entry to be 
deleted. 

2. Click the Delete button.  The time card entry will be removed. 

Note:   If a time card entry was made for multiple employees, deleting the time entry 
for one employee will only delete the time entry for the selected employee. 
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To add new time card entries for individual or multiple employees: 

1. With the Employee Time Cards window open, click the New button.  A time card 
window opens for the selected employee. 

2. Click the Show affected employees disclosure triangle to select multiple employees 
to whom the time card entry should be applied.  Click in the far left column to select 
individual employees, or click Select All to select all employees. 

 
 

Show/Hide 
affected 
employees 

3. Enter the Period, Clock In and Out date and time, and set any Billable Time or 
Break Time.  If for example, time is being entered for a holiday, select the Paid time 
off option. 

4. Click the Add button. The time card window closes and the time card entry is saved 
and added to the time card records for all selected employees. 
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Reports 
Employee Time Reports can be created using the Employee Manager.  Employee Time 
Reports can be formatted by Name, SSN, Period, Week, Month or Year.  A date range for 
the report can be designated by period or by date.  Detail of the report can show the full 
time card or totals only.  Once the report has been formatted, it can be previewed and 
printed. 

To create an employee time report: 

1. Select Admin > Employee Manager from the PrintSmith menu.  The Employee 
Manager opens. 

2. Click the Reports button.  The Employee Time Reports window opens. 

3. Select a Format option from the dropdown list.  Options are:  By Name, By SSN, By 
Period, By Week, By Month, By Year. 

4. Set a Range, either by Period or Date. 

5. Select the level of Detail, either to Show full time card or Show totals only. 

6. Select Employees to include in the report by clicking in the left-most column of the 
employee listing, or click Select All to select all employees. 

 

Select Format 

Set Detail 

Select All 

 
To preview and print an employee time report: 

1. With formatting options set, click the Preview button.  The preview window opens. 

2. Click the Print button to print the report. 

Note:   The Time Card report retains the employees included in the current report 
for the next report. 
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Exports 
The Exports feature of the Employee Manager allows employee time information to be 
exported into a format that can then be imported into a payroll system. 

To export employee time reports: 

1. Select Admin > Employee Manager from the PrintSmith menu.  The Employee 
Manager opens. 

2. Click the Exports button.  The Employee Time Exports window opens. 

3. Select a Format option from the dropdown list, either By Name or By SSN. 

4. Set a Range, either by Period or Date. 

5. Select Employees to include in the export by clicking in the left-most column of the 
employee listing, or click Select All to select all employees. 

6. Set exporting options: 

• Select the Include field name option, if the first line of the export should be the 
field name. 

• Set the Delimited option, either Tab or Comma. 

• Set the Line End option, either <cr> for Mac, or <cr,lf> for PC. 

7. Select the fields to include in the export by clicking the left-most column of the field 
listing, or click Select All to include all fields. 

8. Click the Export button.  A save dialog opens.  Leave the default name, or enter a 
new name for the exported file.  Browse to the location where the file should be 
saved. 

9. Click the Save button.  The file is saved as a *.txt file in the designated location. 

 

Set Line End for 
Mac or PC 

Select fields 
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The Tracker Manager 
The Tracker Manager is the management module for the Tracker Console. From within 
the Tracker Manager, you can get a snapshot view of all Active Items in Production for 
your Facility based on your viewing Preferences. You can also set up Routings that will 
allow you to better manage the flow of work through your facility, and in conjunction with 
Tracker Console timing functionality more effectively track actual job times so that 
estimating job costs becomes easier. Additionally, special Tools are provided to help you 
better manage and work with the vast amount of valuable data collected by the Tracker 
process. 

The Tracker Manager window is accessed from the Admin menu. Select Admin > 
Tracker Manager and the Tracker Manager Window open. 

Opening the Tracker Manager 

 

Select Tracker Manager from 
the Admin menu to open the 
Tracker Manager. 

There are four tabs, or functional sections of the Tracker Manager, where you can 
customize the Tracker module to best fit the needs of your company. The four tabs are 
Active Items, Preference, Routing Setup, and Tools. 

Tracker Manager Window 

 

Active Items, 
Preference, 
Routing Setup, 
and Tools tabs 
provide 
powerful 
functionality for 
managing the 
Tracker module. 

The Facility, as 
set in the 
Preference tab, 
is displayed in 
the title bar. 
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Active Items 
The Active Items tab displays the Items that are currently running in production. You can 
decide which Active Items you want to see by selecting Facilities and Stations in the 
Preference tab of the Tracker Manager. 

Active Items Tab 

 

Sort Active Item 
information by 

clicking on any 
column header. 

(8 of 10) shows 
that you are 
viewing 8 of the 
total 10 Active 
Items. 

Click the 
Refresh button 

to display the 
most current 

information for 
Active Items.

 

Sorting Active Items 
Active Items can be sorted by each of the column headings: Item, Description, Time/Qty, 
Duration, Who, Facility, Station, Location, and Machine. To sort the Active Items by 
information in a column, click on the column header. 

Refreshing the Active Items window 
When you open the Active Items tab of the Tracker Manager, information displayed is 
current as of the time the window was opened. But, production data is always changing 
and to receive the most up to date information, you can refresh the information in the 
window by clicking the Refresh button in the lower left corner of the window. The numbers 
in parentheses (# of #) next to the Refresh button show how many Active Items you are 
viewing out of the total number of Active Items in production. The Active Items you are 
viewing is determined by settings in the Preference tab. 

Accessing Tracker Details for an Active Item 
To see more information regarding Estimated versus Actual time and costs for any job in 
the Active Items listing, double-click on any line item and the Tracker Details window will 
open. Notes can also be added in the Tracker Details window. For additional information 
on the Tracker Details window, please see the Tracker Details section of this manual.  
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Notes 
You can enter Notes about any job by double-clicking on the job in the Active Item listing 
to open the Tracker Details window and typing in the Notes field. Jobs that have Notes 
entered in the Tracker Details window are displayed in the Active Items listing with an 
exclamation point at the far left of the line. 

Informational Icons in the Active Items tab 

 

The double yellow line 
next to an item 

indicates that the job 
has been paused.

 

Active Item Table Definitions 

Column Name Definition 
  

Item A reference number for the job displayed as 0000/0/0 where the first four-digits 
represent the invoice number, the second set of digits represents the job or job 
charges and the last digits represent the steps in the process. 

Description The textual information for the job as set up in the Estimate/Invoice. 

Time/Qty The total estimated time for the job. 

Duration Displays the actual amount of time that the job has been in production 

Who The name of the employee who is working on the Active Item in production. 

Facility The name of the facility where the production step is taking place. You can set 
which Facility you would like to view Active Items for in the Preference tab. 

Station The computer terminal where data for the job is being entered. You can set which 
Station you would like to view Active Items for in the Preference tab. 

Location Where the job step is being completed. 

Machine The Machine ID number as set in the Press Definitions and Copier/Digital 
Definitions windows. 

  

The exclamation point 
next to an item 

indicates that Notes 
have been entered for 

the job.
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Preference 
In the Preference tab of the Tracker Manager you can set options to determine which 
items you would like to view in the Active Items tab. This is a flexible management tool 
that allows you to view the data you need to see, when you want to see it. 

Preference tab 

 

An individual 
Facility can be 
selected from 
the drop-down 
menu. 

Choose to show 
all stations in 

the Active Items 
tab or select 

individual 
stations to view. 

1. To show Active Items for just one facility, click the mouse in the Facility field. A drop-
down menu listing all Facilities (as set in Admin > Table Editor, Production Facilities 
table) will appear. Double-click on the facility name you would like to display. 

2. Place a check in the box next to the Show all facilities option if you would like to see 
Active Items for all facilities. 

3. To show all stations within the facilities you have selected, place a check in the box 
next to the Show all stations option. 

4. If you would like to filter the Active Items tab to only show certain Stations, you can 
select individual stations from the Station box by placing the pointer in the column to 
the left of the Station and clicking the mouse. A black square will appear indicating 
that the Station has been selected. 

5. To unselect a Station, place the pointer in the column to the left of the Station and 
click the mouse. The black box will no longer appear, indicating that the Station is no 
longer selected. 

6. Preferences set will automatically be saved and reflected in the Active Items tab. 
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Routing Setup 
The Tracker module allows you to set up routings for jobs customized for your operation. 
A Routing is a compilation of steps that a job goes through to be completed during the 
production process. Once these routings are established, you can attach them to jobs in 
the Tracker Production window by double-clicking on the job in the Active Items listing of 
the Tracker Console or by selecting Tracker Production in the Job window. For more 
information on attaching routings to a job, please see the Tracker Production Window 
section of this manual. 

You can create standard routing templates for your facility in the Routing Setup tab of the 
Tracker Manager. The routings can be edited or changed during the production process to 
custom fit any job, but should reflect a standard job for your facility. To save you time 
when setting up routings, it is possible to duplicate individual routing steps and entire 
routes. 

Routing Setup tab 

 

If the 
routing is 
very 
typical for 
your 
facility, 
set it as 
the 
default 
route for 
new jobs. 

Give routings a 
unique title that 

will be easily 
identifiable to 

employees 
assigning 

routings to jobs. 

Detailed 
information for 

each step can be 
entered regarding 

location, 
schedule, cost, 

and completion. 

Create new 
routings with up 

to thirty steps. 

Every routing 
created is 
listed with each 
of its steps. 
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Functionality Icons 
The Functionality Icons in the Routing Setup tab of the Tracker Manager allow for easy 
creation, duplication, deletion and editing of routes and routing steps. 

Routing Setup Functionality Icons 

 

New Routing 

The New Routing icon allows you to create a new job routing with as many as thirty steps. 

Duplicate Routing 

The Duplicate Routing icon allows you to create a copy of a previously created routing. 
Select the Routing that you would like to copy from the Routing list and click the Duplicate 
Routing icon. 

New Step 

Click the New Step icon to add additional steps to the routing you are creating. 

Duplicate Step 

Click the Duplicate Step icon to copy a step within a routing. The copied step will be 
added after the original step and can then be dragged to any order within the same 
routing, or be dragged to another routing. 

Delete 

The Delete icon allows you to delete individual routing steps or entire routings. Select the 
Routing or Routing Step that you would like to remove from the Routing list and click the 
Delete icon. 
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Creating a New Routing 
1. Click the New Routing button in the Routing Setup tab to create a new routing. 

2. When the New Routing button is clicked, the fields in the Routing Setup tab are 
activated for editing. A default Route Title New Routing is entered, the Facility is 
automatically set based on your selection in the Preference tab, and the new routing 
is added to the table listing at the bottom of the window. 

Creating a New Routing 

 

Click the New 
Routing button 

to create a new 
routing 

The Facility 
and Location 

are supported 
by the new 
Production 

Facilities and 
Production 
Locations 

tables. 

Enter a 
descriptive Route 

Title. Set what to do once 
the step has been 
completed. 

Schedule the step 
to start based on 
the Ordered or 
Wanted by date. 

The New Routing 
appears in the table 
listing. 

 

3. Enter a Route Title. For ease of use, it is suggested that you give the routing a name 
that is descriptive, i.e. Prepress/Proof/Production/Bindery, so that it is more easily 
selected in the Tracker Production window. 

4. Place a check in the box next to the Disabled option if you want to save the routing, 
but do not want to make it available for selection in the Tracker Production window. 

5. Place a check in the box next to Default route for NEW jobs if you want this routing 
to appear as the default for all newly created jobs. 

6. In the To Here section of Step Details, enter a Facility for the first step. The Facility 
field will automatically be populated based on your setting in the Preference tab, or 
you can select a different facility by clicking in the field and displaying the drop-down 
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menu. The Facility is the physical building where the step will take place and options 
are set in the Production Facilities table. 

7. Select a Location by clicking in the Location field and then double-clicking on one of 
the options that appears in the drop-down menu. If you were creating the first step for 
this routing with the title Prepress/Proof/Production/Bindery, you would choose 
Prepress for the Location. The Location options are set in the Production Locations 
table. 

8. Place a check next to the Disabled option if you want to temporarily remove a piece 
of equipment from service. The routing will still be available in the Tracker Production 
window, but the step that has the Disabled option set will have an X next to it, 
indicating that the equipment associated with the step is not available. 

9. The When Complete area allows you to set options for what to do once this step in 
the routing is complete. 

a. Select the Mark INV ready for pick up option if this is the last step in the 
routing and the invoice should be marked that the job is complete and ready 
for pick up. 

b. Select the Treat as Non-Production step, no cost option, if this is a step 
that should not be charged to the customer. An example of a step that might 
not have a cost is Proofing. 

c. Select a Completion Category from the drop-down menu. Completion 
categories are linked to production and can be used to automatically date 
stamp the completion of a step in the Tracker Production window. Not all 
steps will have a Completion Category. If the Completion Category is set for 
a step, the Completion Category’s date and time will automatically be 
entered in the Tracker Production window. 

Settings for Step Completion 

   

 

Select this option if the 
job will be ready for pick 

up after this step is 

Select this option if the 
customer should not be 

charged for this step.

Select the 
Completion 
Category for 
the Step.  Not 
all steps will 
have a 
Completion 
Category. 
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10. In the Schedule area you have two options for scheduling this step of the job. 

a. Auto schedule days from ordered: Selecting the Auto schedule days from 
ordered option schedules the job step to start a certain number of days from 
the day the job was ordered. For example, if the job was ordered on October 
5th, and you set a value of “5” in the Auto schedule days from ordered 
field, the job will be scheduled to begin on October 10th.  You can also set a 
time for when the step should begin by making a selection from the Hour of 
day drop-down menu. 

b. Auto schedule days from wanted by: Selecting the Auto schedule days 
from wanted by option schedules the job step to start a certain number of 
days from the date the customer has requested the job to be completed. A 
negative or positive number can be set in this field. For example, if the 
customer has requested that the job be completed by November 15th, and 
you set a value of “-7” in the Auto schedule days from wanted by option, 
the job will be scheduled to begin on November 8th. Setting a positive seven 
“7” in this field would cause the job to be scheduled for November 22nd. 
Setting a value of zero “0” in this field will schedule the job for November 
15th. You can also set a time for when the step should begin by making a 
selection from the Hour of day drop-down menu. 

Setting the Routing Schedule 

 

This step is 
scheduled to 
start 5 days 

after the 
customer order 

date at 9am. 

 

Note:  Enter a positive number if using the Auto Schedule days from ordered 
field, and a positive or negative number if using the Auto Schedule days 
from wanted by field. 
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11. The Step Details that you have entered appear in the routing list at the bottom of the 

window for easy viewing. The Route name, Facility, Location, Stop Action, Date 
Stamp, and Auto Schedule information is displayed. 

Viewing the Routing Step Details 

 

 

Routing List Column Definitions 

Column Definition 
  

Route The Routing Title. 

Facility The physical location/building where the step is scheduled to occur. 

Location The Production Location where the step is scheduled to occur. 

Stop Action A possibility of two symbols can occur in this column: 
• A delta symbol (^) means this step is a non-production step and no costing 

information will be collected for the completion of the step. This symbol appears 
when the Treat as Non-Production step, no cost option is selected. 

• A bullet symbol (•) means that completion of this step will mark the invoice ready for 
pickup. A message alert to the user will occur in the Tracker Console prior to this 
occurring, and the user can choose to not have the invoice changed at that time.  
This symbol appears when the Mark INV ready for pickup option is selected. 

Date Stamp If a Completion Category has been set for the step, the name of the Completion Category 
will appear in the Date Stamp column. The Completion Category Date Stamp will 
automatically be updated for jobs with routings assigned. 

Auto Schedule A routing step can be scheduled in two ways: 
• Auto Schedule days from ordered: 2 Day(s) O @ 10 am – appearing in the Auto 

Schedule column means that the step has been scheduled to start two days after 
the order date at 10 am. 

• Auto Schedule days from wanted by:  -8 Day(s) W @ 10 am – appearing in the Auto 
Schedule column means that the step has been scheduled to start eight days before 
the customer wanted by date at 10 am. 
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Adding New Steps to a Routing 
After you finish entering the Step Details for the first step, click the New Step icon to add 
information for the next step in the job routing. The Location drop-down menu 
automatically appears prompting you to enter a Location and a new line for the step is 
added in the routing list. You can set a maximum of thirty steps for a Routing Definition. 
The New Routing you have created will automatically be saved. 

Editing a Routing 
It is possible to edit a previously created routing. Editing a routing that has already been 
assigned to a job will not affect that job’s routing information. 

1. To add a new step to a previously created routing, select any step in the routing you 
wish to change, and click the New Step button. The new step will automatically be 
added as the last step in the routing list. 

2. You can use drag and drop to re-order the routing steps. Click on the step you would 
like to move, and drag it to over the step that it should come before. Release the 
mouse, and the step is now in its new position. 

3. To delete a step from the routing, select the step in the routing list and click the 
Delete button. A confirmation window will appear with the message Ok to delete the 
routing step? Click Yes if you want to delete the step, and click No if you want to 
cancel the delete action. 

Routing Step Deletion Confirmation 

 

Click Yes to delete the 
routing step. 

4. To delete an entire route, select the first line of the route in the routing list, where the 
name is displayed, and click the Delete button. A confirmation window will appear 
with the message Ok to delete the entire routing list? Click Yes if you want to delete 
the routing list, and click No if you want to cancel the delete action. 

Routing List Deletion Confirmation 

 

Click Yes to delete the 
routing list. 
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Duplicating Routings and Steps 
It is likely that many of the job routings through your facility are quite similar with minor 
variations. To save time in the routing creation process it is possible to duplicate both 
entire routings and individual routing steps. 

Duplicate Routing 

To Duplicate a Routing, select any step of the routing that you wish to duplicate from the 
routing list at the bottom of the Routing Setup tab. Click the Duplicate Routing icon. An 
exact copy of the Routing will be added at the bottom of your routing list. Give the newly 
copied routing list a unique name and make any necessary customizations. 

Duplicate Step 

To duplicate an individual routing step, select the step that you would like to copy and click 
the Duplicate Step icon. The copied step will appear in the routing list after the step that 
was copied. Make any necessary customizations to the duplicate step and drag it to a new 
order within the same routing or drag it to another routing. 

 

Routing Setup Definitions 

Field Definition 
  

Route Title A logical and descriptive name for the routing. 

To Here – Facility The physical location/building where the job step will occur. 

To Here – Location The Production Location of the job step. 

Mark INV ready for pickup Select this option if this is the last step in the routing and the invoice will be 
marked ready for pickup. A message alert to the user will occur in the Tracker 
Console prior to this occurring, and the user can choose to not have the invoice 
changed at that time. 

Treat as Non-Production 
step, no cost 

Select this option if the customer should not incur a charge for this step. For 
example: Proofing. 

Completion Category Completion categories are linked to production and can be used to date stamp 
the completion of a step. Not all steps will have a Completion Category. 
Example Completion Category for Running-Print is Printed. 

Auto Schedule days from 
ordered 

Set this option to schedule a step to occur a certain number of days from the 
job’s order date. 

Auto Schedule days from 
wanted by 

Set this option to schedule a step to occur a certain number of days before or 
after the customer wanted by date. 
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Tools 
Tools provided in the Tracker Manager help you allow you to control the amount of 
historical data stored and analyze data through provided reports. 

Clearing Tracker History 
The Tracker module tracks and stores a tremendous amount of data. To properly maintain 
the Tracker module and keep the PrintSmith database at a reasonable size, it is 
recommended that old data be periodically removed from the system. In the editable days 
old field enter the number of days of data to keep. Any Tracker data older than the 
number of days set will be cleared when you click the Clear Tracker history for 
Documents more than button. This setting will not automatically clear your data. You 
must manually select the option.   

Reports 
Production Reports and Employee Reports are available in the Tools tab of the Tracker 
Manager to assist you in analyzing the collected Tracker data. 

Tools Tab 

 

Click here to 
Clear Tracker 

history. 

 

Note:  Clearing the Tracker History does not remove the cost information for the 
invoices. Only the detailed steps used to create the costing record are removed. 
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The Tracker Console 
The Tracker Console is the heart of the Tracker module. It is here that employees collect 
and record the valuable job timing data that will allow you to more accurately estimate job 
costs. Employees login to the Tracker Console and only see the information that is 
relevant to them and are only able to edit jobs based on preferences set in the Personal 
tab and Production Filter of the Employee window. The Tracker Console is accessible 
from the Admin menu. Select Admin > Tracker Console to open the Tracker Console. 

Opening the Tracker Console from the Admin Menu 

 

Select Tracker 
Console from the 
Admin menu to 
open the Tracker 
Console 

 

The Tracker Console Window 

 

The Active Items, 
Preference, and 

Completed Items 
tabs help in the 

workflow and data 
collection process. 

A filtered list 
of Active 
Items that 
are in the 
employee’s 
job queue 

Job Control 
icons 
provide 
actual time 
information 
about the 
job. 

A display of 
Barcode entry 

information. 

The time bar is 
a graphical 

display of the 
time that has 
passed on a 

job. 

A listing of 
the Active 
Items the 
selected 
employee is 
currently 
working on. 
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Active Items 
The Active Items tab of the Tracker Console is the main window that general production 
floor employees will interface with. In the Active Items tab, with production filters set, the 
employee will only see the jobs listed that they need to be working on, and the jobs that 
will be coming into their work queue. Using the Job Control icons, either through mouse or 
touch-screen technology, the employee is able to designate times for when the job is 
started, allow for any pauses in the production process, and accommodate setup and 
washup times. As employees become more familiar with the new workflow, the actual data 
that they are able to collect from the production floor will assist you in better estimating 
future jobs. 

 

Active Items Tab 

 

Select the 
Employee 

name. 

Color-coding in 
the Active Items 
listing shows 
which jobs have 
been released, 
which are 
overdue, and 
which are on 
hold. 

Select the 
Production 

Location. 

Markers in 
the Time Bar 

indicate 
process finish 

points.  

Estimated vs. 
Actual time is 
displayed. 
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Employee Station Login 
Each employee who has been set as an Active employee in PrintSmith will be able to 
login to the Tracker Console. Once they have logged in, they will only be able to see the 
invoices, estimates, due dates, production parents, pricing methods, charge types, 
presses, and copiers that were set for them in the Production Filter. 

1. To display Active Items for an employee, click in the Employee name field. 

2. A list of employee names appears. Double-click on the employee name to display the 
Active Items for that employee. 

Selecting the Employee Profile 

 

Select the 
employee 
name from 
the drop-
down menu. 

 

3. If the Require PIN option was selected in the Personal tab of the Employee window, 
the employee will be prompted to enter their PIN. 

4. The employee can enter their PIN using the keyboard, or by clicking on the disclosure 
triangle in the PIN number window to display the numerical touchpad. 

PIN Entry Window 

 

Enter the PIN here using 
the keyboard. Click the disclosure 

triangle to display the 
numerical touchpad.

 

Notes:  If your facility uses magnetic card readers, simply swipe your card with the 
Tracker Console open to login. 
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Numerical Touchpad Window 

 

The PIN is not displayed 
as it is entered. 

Large buttons allow for easy 
touch-screen entry.

Click OK after you have 
entered your PIN. 

 

5. Click OK after the PIN number has been entered. If an incorrect PIN as been entered, 
a warning message will be displayed, and the user will be returned to the Enter your 
PIN number dialog box to re-enter their PIN. The user will have three chances to 
enter the PIN number. If all chances are exhausted, the user must re-select their 
name from the Employee drop-down menu. 

User Alert for Incorrect PIN entry 

 

Click OK and you will 
be returned to the 
PIN entry dialog box. 

Three Opportunities for PIN entry exhausted 
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Editing the Employee Profile from the Tracker Console 
It is possible to change the employee profile from the Tracker Console. To do this, click on 
the icon next to the Employee name field. The Employee window for the selected 
employee will open with the Production Filter tab active. 

Accessing the Employee Profile from the Tracker Console 

 

Click the people 
icon to open the 
Employee 
window and 
make changes 
to the 
employee’s 
Production 
Filter. 

 

Make any necessary changes to the employee’s Production Filter, then click the File icon 
to save changes and return to the Tracker Console. For more information on editing the 
employee profile please review the Employees Window section of this manual. 

 

Notes:  It is possible to delete an employee record from within the Employee window, but 
if an employee has Active Items in production, the Delete icon cannot be 
selected and the employee record cannot be deleted. 

 

Active Items Listing 
The Active Items Listing shows all active items and items to be released to production. For 
your convenience, the items have been color-coded. Items in red are Past Due. Items in 
blue are Production Parents. Items displayed with a line through them have not been 
released or are on hold. Items in black are of a normal status, have been released to 
production and are ready for the employee to begin working on. Only employees who do 
not have the Hide items not released to production option selected in their Personal 
settings will be able to see jobs that have not been released to production. There are ten 
columns of information displayed for items in the Active Items Listing: Item (number), 
Description, Delivery Date, Production Location, Run Date, Active Location, Estimated, 
Priority, Machine, Account.  

Active Item Listing Color Codes 
• ITEM (red): Past Due 

• ITEM (blue): Production Parent 

• ITEM (strikethrough): On-hold or Not Released to Production 

• ITEM (black): Normal status job, Released to Production 
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Active Items Listing 

 

Notes:  The ability of an employee to see certain status jobs will depend on their 
Production Filter settings. If an employee does not have the Any Past Due option 
selected in their Production Filter, they will not see items displayed in red. If the 
Employee does not have the Production Parent option selected, they will not see 
items displayed in blue. If the employee has items hidden that are not released to 
production, they will not see items displayed with a strikethrough. 

Sorting Columns 
Active Items can be sorted by each of the column headings: Item (number), Description, 
Delivery Date, Production Location, Run Date, Active Location, Estimated, Priority, 
Machine, and Account. To sort the Active Items by information in a column, click on the 
column header. 

Refreshing the Active Items Listing 
When you open the Active Items tab of the Tracker Console, information displayed is 
current as of the time the window was opened. But, production data is always changing 
and to receive the most up to date information, you can refresh the information in the 
window by clicking the Refresh button in the lower left corner of the Active Items Listing.  

Accessing the Tracker Production Window 
Double-click on an item in the Active Items Listing to open the Tracker Production window. 
From the Tracker Production window you can release a job to production, assign a routing 
to a job, and set the priority. 

Active Item Listing Definitions 

Column Name Definition 
  

Item A reference number for the job displayed as 0000/0/0 where the first four-digits 
represent the invoice number, the second set of digits represents the job or job 
charges, and the last digits represent the steps in the process. 

Description A textual description of the overall job and the steps. 

Refresh the 
window to 

display the 
most current 
information. 

Items 
displayed 
in black 
have been 
released to 
production. 
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Column Name Definition 
  

Delivery Date The customer requested delivery date. 

Production Location A Production Location is the name of a process set to indicate what stage a job is at 
in the overall production process. The Production Location is displayed as set in the 
Press Definitions, Copier/Digital Definitions, or Charge Definitions windows. 

Run Date The scheduled Run Date based on Routing Definitions. 

Active Location The location where the job is actually being run. This is the Location that is selected 
in the Current Station area of the Tracker Console when the job is started. 

Estimated The time estimate for overall job and/or step completion. 

Priority The priority of the job as set in the Tracker Production window. 

Machine The Machine ID number as set in the Press Definitions and Copier/Digital 
Definitions windows. 

Account The name of the customer who ordered the job. 

  

Current Station 
The Current Station area shows the Facility, Station name, and Location for the 
employee and active items displayed. The Facility and Station name are preset based on 
where the computer terminal running PrintSmith is located. The Location is the 
Production Location and can be changed by clicking on the Location field and double-
clicking your selection from the drop-down menu that appears. The selected Location will 
appear in the Active Location column of the Active Items listing when the job is started. 

Setting the Production Location 

 

Select the Location by 
double-clicking on one of 
the options in the drop-
down menu. 
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Warning – Invalid Location Selected 

 

If the Location selected is 
not in the assigned routing, 
a warning message 
appears. 

Barcode Input 
For ease of use and to limit congestion at Stations, it is also possible to enter Tracker data 
by using a barcode scanner. The employee can scan the invoice at the beginning and end 
of a job and Tracker data will be entered and saved. Printed Employee records include a 
barcode that represents each employee's PrintSmith ID number. For extra convenience, 
this barcode can be affixed to an employee's badge or a laminated sheet of paper next to 
the computer running the Tracker Console in your shop for easy barcode scanning. 
Several types of information are displayed in the Barcode Input area: Doc, Job, Charge, 
Facility, Location, and Employee. 

Barcode Input 
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Job Tracking Control Buttons Overview 
The job tracking control icons allow the employee to time job processes from start to 
finish. By pushing the Start icon at the beginning of a process and the Stop icon at the end 
of a process, the actual time for the process is recorded. Job tracking control icons are 
only active (selectable) when their selection is allowed. Inactive icons are visible, but 
faded. 

 

Start 
The Start Icon is selected to begin timing a job or job item. 

 

Setup Done 
The Setup Done Icon is selected when the initial setup for a job or job item is 
completed. 

 

Washup 
The Washup icon is selected when printing of a job is completed and the 
press is cleaned for the next job. 

 

Finish Up 
The Finish Up icon is selected when a job charge is complete. 

 

Next Pass 
For multi-pass jobs the Next Pass icon will appear in place of the Stop icon 
when the current pass has been completed and it is time to start the next 
pass. After the completion of the last pass, the Stop icon will appear to stop 
the time for the entire job. 

 

Stop 
The Stop Icon is selected when all steps in the job have been completed. The 
timer is stopped for the job. Selecting the Stop icon opens the Stop Tracker 
Step window. 
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Cancel 
The Cancel Icon is selected if a job is interrupted or falsely started to stop the 
timer and remove any recorded times. A warning message will appear if the 
Cancel Icon is selected to confirm that the process should be canceled. 

 

Pause 
If an employee needs to step away from a process and is not actively working 
on it, the Pause Icon can be selected. This will stop the timer, but not cancel 
the job, so that an accurate time will be recorded for the process. 

 

Continue 
The Continue icon is only available if the Pause Icon has been selected. Click 
the Continue Icon to have the time continue recording after a job has been 
paused. 

 

Open 
The Open icon opens the Invoice or Estimate window. 

 

Job Ticket 
The Job Ticket icon opens the Job Ticket window.  

 

Cutout 
The Cutout icon opens the Cut Diagram window. 
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Job Tracking Control Buttons – Additional Details 
Start Icon 
The Start icon is only selectable after a job has been released to production. To Start the 
Tracker process, select the job that you would like to start from the Active Items listing and 
click the Start icon. When the Start icon is activated, the selected job will appear in the 
selected employee’s Active Item listing and the Timer will be started as well as showing a 
graphical passage of time in the Tracker Time Bar. 

If the employee tries to start a job that they have already started, a warning message will 
be displayed asking if they would like to restart the beginning timers. It is not possible for 
an individual employee to start the same active item more than once, but it is possible for 
multiple employees to start the same item, as it may be necessary for more than one 
production personnel to work on the same production process at the same time. In this 
instance, information for both employees will be tracked and is viewable in the Tracker 
Status window. 

Warning message for Starting an Item already started. 

 

 

After the Start icon has been activated, the following icons become available for activation 
when the job is selected in the Employee Active Item Listing: Setup Done icon, Stop icon, 
Cancel icon, Pause icon.  

Icons available after Start selected 
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Setup Done Icon 
The Setup Done icon is available for selection after the Start icon has been activated and 
the job is selected in the Employee Active Item Listing. The time period between the Start 
Icon being activated and the Setup Done icon being activated relates to all processes 
necessary to prepare for the actual job run, such as doing the make-ready. Timing this 
stage of the production process allows you to get a more accurate estimate of how long a 
job actually takes.  

The estimated time for the Setup process is displayed in the Time Bar in green. The 
estimated setup time is marked in the Time Bar with a blue triangle at the top of the Time 
Bar. When Setup is complete and the process is ready to begin, select the Setup Done 
icon. Selecting the Setup Done places a blue triangle at the bottom of the Time Bar. 
Selecting the Setup Done icon indicates that setup is done and the production process 
has started. At this point, the Setup Time will be recorded in the Tracker Details window. 

Setup Done indicators in the Time Bar 

 

 

The estimated 
setup time is 
displayed in 

green.  

A blue triangle 
appears at the 
bottom of the 
Time Bar when 
the Setup Done 
icon is selected. 

After the Setup Done icon is selected, either the Washup or Finish up icons will become 
available for selection, depending on the type of production process. 

Washup available after Setup Done selected 

 

Finish Up available after Setup Done selected 
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Washup and Finish Up Icons 
The Washup and Finish Up icons are available for selection after the Setup Done icon has 
been activated. The Washup icon is available for printing processes that require a 
Washup, and the Finish Up icon is available for other job charges. Activating the Washup 
icon or the Finish Up icon indicates that the main process has been completed and the 
time is recorded, but time for the after process should be recorded as part of the overall 
time expenditure for a job so that accurate costs can be calculated. 

When the Washup icon or Finish Up icon is selected, a red triangle appears at the bottom 
of the Tracker Time Bar as a visual indication of when main process was completed and 
the Washup/Finish Up process began. 

Tracker Time Bar after Washup/Finish Up Selected 

 

A red triangle 
appears in the 
Tracker Time 
Bar when the 
Washup icon is 
selected. 

 

Once the Washup or Finish Up Process has been completed, the Stop icon can be 
activated to indicate that the entire job process is complete. 

Washup and Finish Up times are recorded in the Tracker Details window. 

 

Stop Icon 
The Stop icon is available for selection after the Start icon has been activated for all single 
pass jobs and the job is selected in the Employee Active Item Listing. The Stop icon is 
available for multi-pass jobs once the last pass has been started. Selecting the Stop icon 
indicates that all processes for the job are complete and that Tracker Timing should be 
stopped. 

When the Stop icon is activated, the Stop Tracker Step window opens. To complete the 
Stop action, review the information, add any notes, and click OK. For more information, 
see the Stop Tracker Step section of this manual. 
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The Stop Tracker Step window opens when the Stop icon is selected 

 

After clicking OK in the Stop Tracker Step window, if a routing has been assigned to the 
job and this step is the last step of the job, a message may appear: “This step will mark 
the invoice complete and ready for pickup. All other production steps should be done. 
Should the invoice be marked complete?” Select Yes if the invoice should be marked 
complete; No if it should not be; or Cancel to cancel the Stop Tracker Step action. 

Marking the Invoice Complete after Stop Step 

 

If the step is not the last in the production process it will move out of the selected 
employee’s Active Item Listing and into the next stage of the production process. 
Regardless of whether or not it is the last step of the job, the item will be accessible in the 
Completed Items tab of the Tracker Console. This allows employees convenient access to 
information about the item after it has moved out of the Employee Active Item Listing. For 
additional information about the Completed Items tab, please see the Completed Items 
section of this manual. 

For the last step in the Tracker process, the invoice will be marked ready for pickup if that 
setting was selected in the routing setup. Additionally, the completed item will appear in 
the Tracker Status window with a complete status, indicated by a checkmark in the Status 
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column and a Current Status of Completed. For additional information about the Tracker 
Status window please review the Tracker Status section of this manual. 

Completed Item in Tracker Status window 

 

The current 
status of 
the 
selected 
item is 
Completed. 

A check mark in 
the Status 

column 
indicates that 

the step is 
complete. 

Notes: The Stop icon can be selected at any point while the job is actively in production 
to view the information in the Stop Tracker Step window, but you must select 
Cancel in the Stop Tracker Step window to continue the job process. For normal 
workflow, if you wish to view additional information about the job, it is best to 
access the Tracker Details window by double-clicking on the job in the Employee 
Active Item Listing, or by double-clicking in the Tracker Time Bar with the job 
selected in the Employee Active Item Listing. 

Cancel Icon 
The Cancel icon is available for selection after the Start icon has been activated and the 
job is selected in the Employee Active Item Listing. The Cancel Icon is selected if a job is 
interrupted and needs to be restarted or falsely started to stop the timer and remove any 
recorded times. A warning message will appear if the Cancel Icon is selected to confirm 
that the process should be canceled. 

Confirmation to Cancel Process 
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If the Cancel icon has been selected accidentally, when the confirmation message 
appears, the employee can select No, and the Tracker Timing process will continue with 
no data lost. To confirm cancellation of the process, click Yes. When the Cancel activation 
is confirmed, the item is removed from the Employee Active Item Listing, but still will still 
be available for selection to Start in the Active Item Listing. All data collected will be 
removed and if the job is started again, all numeric data will be fresh. A record of the 
Cancelled process will appear in the Tracker Status window, so that a manager or 
supervisor can monitor work on a job. 

 Cancel Line Item in Tracker Status Window 

 

The Cancel 
action is 

recorded as a 
line item in the 
Tracker Status 

window with the 
Cancel icon 

displayed in the 
Status column.  

 

Pause and Continue Icons 
The Pause icon is available for selection after the Start icon has been activated and the 
job is selected in the Employee Active Item Listing. Because collecting accurate data that 
is important to future estimations, the Tracker module allows for real-world flexibility 
through the Pause icon. If an employee is called away from their machine or a process, 
they can select the Pause icon to stop the time, but retain data collected up to that point. 
Then, when the employee is ready to resume activities that should be timed by the 
Tracker, the Continue icon can be activated and timing will resume where it was last left. 

When a job is paused, the Time Bar is displayed in yellow, and the Tracker Timer stops. 
The Continue icon becomes available for activation.  

Time Bar after the Pause icon is selected 

 

The Timer tracking 
actual time is stopped 

when the Pause icon is 
selected. 

 The Time Bar is 
yellow when the 
Pause icon is 
selected.
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After the Pause icon is selected 

 

 

Paused Item in the Employee Active Item Listing 

 

The Pause icon 
appears next to 

the item number of 
the job that has 

been paused. 

Next Pass Icon 
The Next Pass icon is available for selection after the Start icon has been activated for 
jobs that require multiple passes. The Next Pass icon replaces the Stop icon in the button 
display area, until the last pass has been completed. The Next Pass icon should be 
selected after the washup for the current pass has been completed. Once the Next Pass 
icon is activated, the Setup Done icon is available for selection and you can begin timing 
the next pass of the process. Once the last pass of a multiple pass job has been started, 
the Next Pass icon will be replaced with the Stop icon. 

The Next Pass icon replaces the Stop icon until all passes are complete 

 

 
Page 69 



EFI PrintSmith 8.0 │ Tracker Module Instructions 

 
 

For jobs with multiple passes, the number of passes is displayed by the Tracker Time Bar 
as Pass (# of #) to let you know which pass of the total number of passes is currently 
being tracked. 

 Pass information displayed by the Time Bar 

 

Information for each pass of a job is displayed in the Tracker Details window, which can 
be accessed by double-clicking on the Tracker Time Bar. For more information on Tracker 
Details for multi-pass jobs please the Tracker Details section of this manual. 

Open Icon 
The Open icon is selectable at anytime during the Tracker process. Select the item invoice 
or estimate that you would like to view, either from the Active Items Listing or the 
Employee Active Item Listing and then click the Open icon. The Invoice or Estimate 
window will open. 

Job Ticket Icon 
The Job Ticket Icon is selectable at anytime during the Tracker process. Select the item 
whose Job Ticket you would like to view from the Active Item Listing or the Employee 
Active Item Listing and click the Job Ticket icon. The Job Ticket Window opens. Opening 
the Job Ticket does not interfere with the Tracker process. Close the Job Ticket Window 
when you are through viewing or printing it. 

Opening the Job Ticket from the Tracker 
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Cutout Icon 
Clicking the Cutout Icon will open the Cut Diagram window, showing Starting Size, Size 
Out, Sheets Out, and Waste percentage. The Cutout icon is only available for selection for 
those job steps with Cutout information. 

Cut Diagram 

 

Job Tracking Control Icon Definitions 

Icon Name Definition 
  

Start Select the Start icon to begin timing a job or job item so that Tracker data can be 
collected. 

Setup Done Select the Setup Done icon when the initial setup steps for a job or job charge item are 
completed. Setup time will be recorded and timing of the main process will begin. 

Finish Up Select the Finish Up icon when the main process of a charge is complete and the 
machine is prepared for the next job. Main process times will be recorded and the time 
will continue to collect finish up time data. 

Washup Select the Washup icon when printing of a job is complete and the press is being cleaned 
for the next job. Main printing times will be recorded and the timer will continue to collect 
washup time data. 

Next Pass The Next Pass icon will appear in place of the Stop icon for multi-pass jobs until the last 
pass is started. Select the Next Pass icon when the current pass has been completed 
and setup for the next pass should begin. 

Stop Select the Stop icon when all steps in the job have been completed. Selecting the Stop 
icon will stop the Time Data collection and open the Stop Tracker Step window. 

Cancel Select the Cancel icon if a job is interrupted and needs to be restarted or is falsely started 
to stop the timer, remove any recorded times, and move the job out of the Employee 
Active Item Listing. A warning message appears to confirm that the job should be 
canceled. 

Pause Select the Pause icon if a job is in process, but it is not actively being worked on. This 
allows the current Tracker Data to be saved and continued once work on the process is 
continued. 

Continue Select the Continue icon to continue timing and data collection for a job that has been 
paused. 
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Icon Name Definition 
  

Open Select the Open icon to open the Invoice or Estimate window. 

Job Ticket Select the Job Ticket icon to open the Job Ticket window. 

Cutout Select the Cutout icon to view the Cut Diagram window. 

  

 

Tracker Time Bar 
The Tracker Time Bar is a graphical display of the time that has passed in a job. When the 
Start icon is selected for a job, the Tracker begins to record the time that it takes for setup 
steps, the main process, and finish up steps to occur. The Tracker Time Bar display gives 
visual indicators of both estimated and actual time. The Tracker Details window can be 
accessed by double-clicking on the Tracker Time Bar. 

Tracker Time Bar 

 

Color Codes 
Three colors are used to indicate different information about the time process of a job. 

• Green – indicates the estimated setup time for a job. 

 

• Blue – indicates the main process and finish up/washup time for a job. 

 

• Yellow – indicates that the Pause icon or Stop icon have been selected. 

 

Triangle Time Markers 
Triangle time markers in the Tracker Time Bar give additional information about Tracker 
time. The blue triangle in the top of the Tracker Time Bar is an indicator of estimated setup 
time, or when setup should be complete. For multi-pass jobs, the top blue triangle appears 
with a white line dividing it. A blue triangle is displayed at the bottom of the Tracker Time 
Bar when the Setup Done icon is selected, indicating the actual time for completing the 
setup process. A red triangle is displayed at the bottom of the Tracker Time Bar when the 
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Washup or Finish Up icon is selected indicating that the main process has been 
completed and the finishing steps have started. 

Time Marker Indicators 

 

 

The bottom blue 
triangle marks 
that the Setup 
Done icon has 
been selected.

The bottom 
red triangle 
marks that 

the Washup 
icon has 

been 
selected. 

The top blue triangle 
marks the estimated time 
for setup.  

 

 

 

Machine Name 
The Machine Name where the selected item is produced on appears in the middle of the 
Tracker Time Bar. The Machine Name is a new field and must be set in the Press 
Definitions or Copier/Digital Definitions window to be displayed. For information on setting 
up Machine Names, see the Setting Up the Tracker Module section of this manual. 

 

Digital Timer 
The Digital Timer to the right of the Tracker Time Bar shows Estimated versus Actual time. 
The Actual Time is 0:00 before the job is started. After the Start icon has been clicked the 
timer is started and the Actual Time is incremented as the graphical display of time moves 
across the Tracker Time Bar. If the job is paused or stopped, both the time bar and the 
Actual timer stop incrementing. If the Actual Time exceeds the Estimated Time, the Digital 
Timer will display in red. 

 

Tracker Time Bar before the Start icon is selected 

 

 The Machine Name for the 
selected item displays in the Time 

Bar when setup.

Estimated vs. Actual time 
is displayed.  Actual Time 
is 0:00 before the item is 
started.  

 

Actual Time exceeds Estimated Time 
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Multi-pass Information 
There are two indicators in the Tracker Time Bar to let the employee know that the active 
item is a multi-pass job. Text to the left of the Tracker Time Bar Pass (# of #) shows the 
current pass out of the total number of passes for the entire job. In the Tracker Time Bar, 
the top blue triangle is displayed with a white line dividing it, which also indicates that it is 
a multi-pass job. The Digital Timer displays the Estimated Time for each pass and the 
Actual Time is set to zero at the beginning of each pass. 

Tracker Time Bar for a Multi-pass job 

 

Estimated vs. Actual 
time for the individual 

pass is displayed.

 Pass information displays 
which pass of a multi-pass 
job is currently active.  

Notes:  The Machine Name will not display in the Tracker Time Bar unless the Machine 
Name has been set in the Press Definitions or Copier/Digital Definitions window. 
Please see the Setting Up the Tracker Console section of this manual for 
additional information. 

 

Employee Active Items Listing 
The Employee Active Items Listing, located in the bottom portion of the Tracker Console 
window, displays only those items that the selected employee is currently working on. 
While the employee may be able to view Production Parents, jobs not yet released to 
production, or other jobs in the top Active Item Listing, this view allows the employee to 
easily focus their attention on the jobs that they currently have in progress. 

 

Employee Active Item Listing 

 

(2 of 6) 
shows that 
you are 
viewing 2 of 
the total 6 
Active 
Items 

Sort Active 
Item 

information 
by clicking 

Click Refresh 
to display the 
most current 

Active Item 
information  
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Column Information 
The column information displayed in the Employee Active Item Listing is similar to that 
displayed in the main Active Items Listing, with a few variations. 

• Item – A reference number for the job or charge. 

• Description – A textual description of the job or charge as set up in the Invoice or 
Estimate. 

• Time/Qty – The total estimated time for the job. 

• Duration – The actual amount of time the job has been in production. 

• Who – The name of the selected employee who is working on the production item. 

• Facility – The physical location/building where the item is in production. 

• Station – The computer terminal where data is being collected for the item in 
production. 

• Location - The equivalent of Active Location in the Active Items listing that comes 
from the Current Station Location setting. 

• Machine – The ID of the Machine where the production process is occurring. 

• Account – The equivalent of Account in the Active Items Listing, but only the Account 
number and not the Account name is displayed. 

Sorting Columns 
Employee Active Items can be sorted by each of the column headings: Item (number), 
Description, Time/Qty, Duration, Facility, Station, Location, Machine, and Account. To sort 
the Active Items by information in a column, click on the column header. 

Refreshing the Employee Active Items Listing 
When the employee name is selected in the Tracker Console, information displayed is 
current as of the time the window was opened. But, production data is always changing 
and to receive the most up to date information, you can refresh the information in the 
window by clicking the Refresh button in the lower left corner of the window. The numbers 
in parentheses (# of #) next to the Refresh button show how many Active Items the 
selected employee is actively working on out of the total number of Active Items in 
production. 

Accessing the Tracker Details for an Active Item 
The employee has two options for accessing the Tracker Details window to see more 
information regarding Estimated versus Actual time and costs for any job in the Employee 
Active Items listing, if their settings in the Personal Tab of the Employee Window allow it. 
Notes can also be added in the Tracker Details window. For additional information on the 
Tracker Details window, please see the Tracker Details section of this manual.  
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To open the Tracker Details Window, the employee can: 

• Double-click on any line item in the Employee Active Items Listing and the Tracker 
Details window will open. 

• With the line item selected in the Employee Active Items Listing selected, click on any 
area of the Tracker Time Bar. 

Employee Active Item Listing Definitions 

Column Name Definition 
  

Item A reference number for the job displayed as 0000/0/0 where the first four-digits 
represent the job number, the second set of digits represents the process part of the 
job, and the last digits represent the steps in the process. 

Description The textual information for the job as set up in the Estimate/Invoice. 

Time/Qty The total estimated time for the job. 

Duration Displays the actual amount of time that the job has been in production 

Who The name of the employee who is working on the Active Item in production. This 
name is the same as the employee name selected in the Tracker Console. 

Facility The name of the facility where the production step is taking place. You can set 
which Facility you would like to view Active Items for in the Preference tab. 

Station The computer terminal where data for the job is being entered. You can set which 
Station you would like to view Active Items for in the Preference tab. 

Location Where the job step is being completed, as determined by the Current Station 
Location when the job step is started. 

Machine The name or number of the machine that is being used to complete the job step. 

Account The number of the account (customer), but not the account name, is displayed. 

  

 

 
Page 76 



Tracker Console 

 

Preference 
The Preference tab of the Tracker Console allows you to make further customizations to 
the view in the Active Items tab. You can set where to start new items, which pending 
items to show, which active items to show, and set the font in which the Pending List and 
Active List are displayed. 

Preference Tab 

 

Set where to 
start new 

items. 
Customize font 
size for the 
Pending and 
Active Lists. 

Set which 
pending 
times to 

show. 

Set which 
active items 

to show. 
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Start new items here 
You can designate a default location for where you would like new items to be started. 
Select the Facility and the Station name from the drop-down menus. This is an additional 
filter setting for the Workstation, but will not set an automatic starting location. 

Setting where to start new items 

 

 

Show these pending items 
In the Preference tab you can set which pending items to show in the Tracker Console. 
There are two options that can be set: Hide items not released to production and Only 
show employee’s Production Parents. 

Hide items not released to production 

Selecting this option will only display those items that have been released to production. 
This setting works in conjunction with the filter set for the selected employee. 

Only show employee’s Production Parents 

Selecting this option will only display those items that are pending for the selected 
employee. Active items that are not at the selected employee’s stage in the production 
process will not be displayed. 

Setting which pending items to display 
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Show these active items 
In the Preference tab you can set which active items to show in the Tracker Console. You 
can select to show: Active employee only and Show all facilities. For stations, you can 
select to show all stations or select individual stations from the Station list. 

Setting which active items to display 

 

 

Font Settings 
Font settings in the Preference tab allow you to change the size of the font in the Pending 
List and Active List to small, medium, or large. Set large fonts if your facility utilizes touch 
screen technology. Please note that in order for changes to the font settings to take effect, 
the Tracker Console must first be closed and then re-opened. 

Determining Font Settings for Pending and Active Lists 
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Completed Items 
The Completed Items tab is a temporary log of all items that have been completed at the 
Workstation. Once a job has had reached the Stop Tracker Step stage, it will be removed 
from the Active Items tab listing and appear in chronological order in the Completed Items 
listing. This view has been provided as a convenient way to access information about jobs 
that have just been completed. Information in the Completed Items tab is cleared when 
the Tracker Console is closed or when the PrintSmith application is exited. 

Completed Items Tab 

 

Sorting Columns 
Completed Items can be sorted by each of the column headings: Date Completed, Item, 
Description, Time/Qty, Duration, Who, Facility, Station, Location, and Machine. To sort the 
Completed Items by information in a column, click on the column header. 

Sort 
Completed 
Item 
information 
by clicking 
on any 
column 
header. 

Click the 
Clear button 

to remove all 
items from 

the 
Completed 
Items tab.

The 
exclamation 

point next to an 
Item indicates  

Notes. 

Double-
click on a 
line item to 
view 
Tracker 
Details.

Accessing the Tracker Details 
Double-click on an item in the Completed Items tab to open the Tracker Details window 
and view additional information regarding Estimated versus Actual time and costs for any 
job, if your settings in the Personal Tab of the Employee window allow it. If you attempt to 
access Tracker Details for an item not assigned to you, a warning message will appear. 
Notes can also be added in the Tracker Details window. For additional information on the 
Tracker Details window, please see the Tracker Details section of this manual. 

Accessing Completed Item Details for a Different Employee 
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Clearing Completed Items 
The Completed Items tab will be cleared every time the Tracker module is closed or the 
PrintSmith application is exited. However, depending on the volume of items being 
completed in your facility, it may become necessary to clear the Completed Items tab 
more frequently. A Clear button has been provided at the bottom left corner of the window. 
Note that there is no confirmation for clearing the window. Once the Clear button is 
selected, all items in the Completed Items tab will be removed. 

Confirm Clearing the Completed Items tab upon exit 

 

A confirmation 
for clearing 
Completed 
Items occurs 
when exiting 
the 
application, 
but not when 
using the 
Clear button. 

 
 

Completed Items Table Definitions 
Column Name Definition 

  

Date Completed The date MM/DD/YYYY, time H:MM am/pm, and day of the week that the item was 
completed. 

Item A reference number for the job displayed as 0000/0/0 where the first four-digits 
represent the job number, the second set of digits represents the process part of 
the job, and the last digits represent the steps in the process. 

Description The textual information for the job as set up in the Estimate/Invoice. 

Time/Qty The total estimated time for the job. 

Duration Displays the actual amount of time that the job has been in production 

Who The name of the employee who is working on the Active Item in production. 

Facility The name of the facility where the production step is taking place. You can set 
which Facility you would like to view Active Items for in the Preference tab. 

Station The computer terminal where data for the job is being entered. You can set which 
Station you would like to view Active Items for in the Preference tab. 

Location Where the job step is being completed. 

Machine The name or number of the machine that is being used to complete the job step. 

  

 

Notes: Closing the Tracker Console or exiting the PrintSmith application will clear the 
Completed Items tab. 
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Tracker Production Window 
The Tracker Production Window allows you to release a job to production, assign and 
customize the job routing, schedule or reschedule a job, set a priority for the job, and 
manually enter or view auto-populated completion dates.  

Tracker Production Window 

 

Release 
the job to 
production. 

Assign a routing 
to the job and 
customize the 

routing. 
Completion 
Category 
date stamp. 

 

Notes: You will only be able to make modifications in the Tracker Production window if the 
security settings in your employee profile allow it. 
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Accessing the Tracker Production Window 
The Tracker Production window can be accessed in two places: by clicking on the Tracker 
Production Command in the left pane of the Job window or by double-clicking on a job in 
the Active Items listing of the Tracker Console. 

Accessing the Tracker Production window from the Job window 

 

Click Tracker 
Production 

under 
Commands 
to open the 

Tracker 
Production 

window. 

 

Accessing the Tracker Production window from the Tracker Console 

 

Double-
click any 
item in the 
Active 
Items tab 
of the 
Tracker 
Console to 
open the 
Tracker 
Production 
window. 
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Functionality Toolbar 
This toolbar lets you perform common functions with the mouse. The File and Print icons 
have equivalent menu commands and are subject to the same security as the menu 
commands.  

Tracker Production Window Functionality Toolbar 

 

File 

The File icon saves the Tracker Production information in the PrintSmith database and 
closes the Tracker Production window. 

Cancel 

Click the Cancel icon to undo any changes made to the job record in the Tracker 
Production window since it was last saved. The Tracker Production window will close 
when the Cancel icon is selected. 

Print 

The Print icon is equivalent to selecting Print from the File menu. It is used when you want 
to generate a hard copy of the Job Charge document. The Job Charge document prints 
with a listing of all charges for jobs and equivalent barcodes. If your facility supports 
barcode scanner technology, you can scan the job charges to update Tracker time rather 
than inputting data at the workstation running the Tracker Console. Before a document is 
printed, it is first filed. 

Release to production 

Placing a check in the box next to the Release to production option will change the item to 
an Active Status and it will be ready for data collection in the Tracker module. The job will 
no longer appear with a line through it in the Active Items tab in the Tracker Console and 
the Start button will be selectable to begin timing the job and its production steps. Jobs 
can also be released to Production from the Tracker Status window. 

Attach to job ticket 

Placing a check in the box next to the Attach to job ticket option will print the Job Routing 
Ticket when the Job Ticket is printed as well as a separate sheet of paper containing 
Tracker Locations with barcodes. 
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Assigning and Customizing a Routing 
Routings that were defined in the Routing Setup tab of the Tracker Manager are 
selectable for assigning to a job in the Tracker Production window. A routing is a 
compilation of steps that a job goes through during the production process. The Routings 
that were defined in the Tracker Manager are templates, and can be further customized to 
fit the exact specifications of the job in the Tracker Production window. Steps can be 
added or removed and the Run Date and Time can be changed. 

Routing Drop-down menu 

Select a Routing from the Routing drop-down menu. The Routing Title should be 
descriptive of the general template so that it will be easy for you to tell which routing is 
most appropriate for the selected job. 

Routing Steps 

Once you have selected a Routing from the drop-down menu, the steps of the routing will 
appear in the table below. The Facility name, Production Location, Total Estimate Time, 
Run Date, and Run Time for each step are displayed. 

Removing Steps from a Routing 

There are two ways that you can remove a step from the routing template. You can either 
highlight the step you would like to remove and click the Remove button, or you can click 
in the X column of the Routing table. If you click the Remove button, the step will no 
longer appear in the Routing listing. If you click the X column, the routing step will still be 
displayed, but the Total Est Time, Run Date, and Run Time fields will be cleared. To re-
add a step that has been marked with an X, simply click the X again. This will remove the 
X and re-enter the Total Est Time, Run Date, and Run Time. 

Adding New Steps to a Routing 

To further customize the routing template additional steps can be added to the Routing. 
To add a new step, highlight the step that the new step should come before and click the 
New Step button. A new line with a Total Est Time of 0:00 and a Run Date with today’s 
date will appear. Select the Facility and Location from the drop-down menus that are 
below the Routing table. To set the Run Date, with the step still highlighted, click in the 
Run Date Column. Enter the date in a MM/DD/YYYY format. The Run Time can be 
entered in the same way by clicking in the Run Time column/field for that job and entering 
a time in a HH:MM AM/PM format. 
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Changing the Run Date and Time for a Job 

The Run Date and Run Time fields for each step will automatically be populated based on 
the Schedule set for the routing in the Tracker Manager. The step, by default, will either be 
scheduled to begin a certain number of days after the order date, or a certain number of 
days before the wanted by date. For more information on Scheduling steps, please see 
the Routing Setup section of this manual. 

To change the Run Date for a step, click in the Run Date field and enter the date. The 
date can be entered as MMDD and the year will be set to the current year. The date can 
also be entered as MMDDYY or MMDDYYYY. By double-clicking in the Run Date field, 
you can edit individual portions of the date. The Run Date can also be changed by using 
the Selection Bump function. 

To change the Run Time for a step, click in the Run Time field and enter the time. If you 
just wish to enter the hour, AM/PM will automatically be entered based on this schedule 7 
AM – 11 AM, and 12 PM – 6 PM. You can also enter the time as HHMM, supplying the 
minutes, and change the AM/PM setting. 

Selection Bump 

You can also change the Run Date by using the Selection Bump +/- buttons. If a step 
needs to occur one day later than scheduled, select the step and click the + button. The 
Run Date for the step will be incremented/pushed back one day each time the + button is 
clicked. If a step needs to occur one day earlier than scheduled, select the step and click 
the – button. The Run Date for the step will be moved forward one day each time the – 
button is clicked. 

Bumping the Entire Routing 

To bump the Run Date for the entire routing, either ahead or back a certain number of 
days, select all of the steps in the routing, either using the Shift key to select a range, or 
the Ctrl key to select each step individually. Then, with all or multiple steps selected, click 
the bump + or – key. 

Total Est Time 

The Total Est Time field displays the total estimated time for the step. This field will only 
be populated if costing has been set up for the item. 

Notes:  A change in the Wanted By dates of an invoice will automatically update the 
Tracker Routing dates. 
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Sorting Routing Steps 

Using Drag and Drop is an easy way to re-order the routing steps in the routing table. 
Select any step in the routing and drag it where you would like it to be in the routing order. 
If you would like to sort the routings steps by run date, click the Sort by run date button 
below the routing steps table. 

Scheduling Routing in the Tracker Production Window 

 

Clicking the x 
column removes a 

step from the 
routing but it is still 

visible.

Select one of the 
pre-configured 
Routings from the 
Routing drop-down 
menu. 

Click the Remove 
button to remove a 
step from the 
Routing. 

Click the New step 
button for each 

step you want to 
add to the routing.

Click the Sort by 
run date button to 
sort the routing 
steps by their Run 
Date. 

 

Use the selection 
bump +/- buttons 
to move the Run 
Date day(s) later 

or earlier.

Priority 

It is possible to set a priority for the job. Priorities are customizable based on your internal 
priority definitions. Priorities are defined in the Production Priorities table. You can edit the 
table by selecting Admin > Table Editor and opening the Production Priorities table. The 
Priority is displayed in the Active Items listing of the Tracker Console. It is not necessary 
for the job’s Priority to be set and can be utilized based on your organization’s needs. 

Actual Time 

The Actual Time field displays the total amount of time the job has been running based on 
Tracker Console entries. 

Actual Count 

The Actual Count field displays Actual Count information from the Tracker Console once 
the Stop step is initiated. 

Actual Waste 

The Actual Waste field displays Actual Waste information for the Tracker Console once 
the Stop step is initiated. 
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Current Location 

The Current Location field displays the Production Location where the job currently is in 
the production process at the time the Tracker Production window was opened. 

Additional Settings and Information in the Tracker Production window 

 

 

Completion Category 
Completion Category date stamps for completion times can be manually entered, or the 
date stamp completion times will be automatically entered if a routing has been assigned. 
For those routing steps which have a Completion Category set in the When Complete 
area of the Routing Setup tab of the Tracker Manager, the Completion Category date 
stamp will be updated in the Tracker Production window and the Production Data window 
when the Stop Tracker Step occurs. For additional information on setting Completion 
Categories and automatically entering date stamps, please see the Routing Setup section 
of this manual. 

Completion Category Date/Timestamp in Tracker Production Window 

 

Completion date 
stamps can be 
manually entered, 
or automatically 
updated with 
routings assigned. 
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Tracker Details 
The Tracker Details window displays data collection information about Active and 
Completed Items. For the item, which can be identified by its item number and description, 
the user can see the Status, the Facility where the item was completed, the workstation 
where data collection occurred, the Production Location where the item was completed or 
is in progress, the Employee working on the item, the Completion Date and Exception 
Codes for Completed Items, Estimated versus Actual Time and Cost information, and any 
Notes. Information available in the Tracker Details window will vary based on its status in 
the production process, the access levels of the employee viewing the record, and 
whether or not it is a single or multi-pass job. 

The Tracker Details window can be accessed from many locations within the Tracker 
module including: the Active Items tab of the Tracker Console, the Completed Items tab of 
the Tracker Console, the Active Items tab of the Tracker Manager, and the Tracker Status 
window. From all of these locations within the application it is possible to open the Tracker 
Details window by simply double-clicking on the item in the listing. 

Tracker Details for an Active Item 

 

Status is Active 
for all items still 

in progress. 

Estimated 
and Actual 
Time and 
Cost 
information is 
displayed. 

Notes about the 
job can be 

typed here. 
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Tracker Details for a Completed Job 
The Tracker Details window is updated with additional information once the Stop Tracker 
Step has been completed. Additional fields in the Tracker Details Window for Completed 
Items are:  

Completed: The Completed field gives the Date and Time when the Stop Tracker Step 
occurred. 

Exception code: The Exception code can be entered in the Stop Tracker Step if a 
problem has occurred during the production process. Exception codes are customizable to 
your facility and should be set up in the Production Exceptions table. The benefit of setting 
up these Exception codes is that it allows employees to quickly note any problems during 
the production process by making a selection from a drop-down menu, rather than having 
to handwrite or type the note. 

Tracker Details Window for a Completed Job 

 

The Status is 
Completed. The Completed 

field displays the 
date and time the 

Stop Tracker Step 
occurred. 

The Exception 
code field is 

supported by the 
new Production 

Exceptions table. 

The Total 
Actual Cost 
displayed 
with the Total 
Estimate 
Cost lets you 
analyze and 
improve how 
you are 
estimating 
costs. 
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Tracker Details with Hidden Costs 
For reasons of privacy, accounting, or company policy, you may not want the Employee to 
see costs related to labor and stock utilization for a job. An option in the Personal tab of 
the Employees window allows you to hide costing amounts. With this option enabled the 
employee will not be able to see: Estimated Stock Cost, Estimated Labor Cost, Estimated 
Cost, and Actual Cost in the Tracker Details window. The fields are present, but no cost 
information is displayed. 

Tracker Details with Costs Hidden 

 

Cost information is 
not displayed. 
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Tracker Details for a Multi-Pass Job 
For jobs that require multiple passes, you may want to view information for the current 
pass separately from the cumulative data collected for the entire job. The Tracker Details 
window allows for this. Different from the Tracker Details window, the Actual times are 
split into two columns, Current Pass and Previous Passes. The Pass information is only 
available for items with an Active Status. Once the item has a Completed Status, the 
cumulative data for all passes is displayed as one Actual total. 

• Current Pass: Shows Total time, Setup time, Run time, and Washup time for the 
pass actively in production. 

• Previous Passes: Shows cumulative Setup time, Run time, and Washup time for all 
previous passes as a total. For example, if a job requires three passes, and the job is 
on its third pass, the Current Pass column will display information for Pass 3. The 
Previous Passes column will display combined time totals for Pass 1 and Pass 2. 

Tracker Details Window for a Multi-Pass Job 

 

Multi-pass time 
data is only 

displayed for 
items with an 
Active status. 

Time data for 
the Current 
Pass is 
displayed. 

The Estimated 
data displayed 
is for the entire 
job inclusive of 

all passes. 

Cumulative data 
for all Previous 
Passes is 
displayed. 
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 Tracker Details Definitions 

Field Definition 
  

Item A reference number for the job displayed as 0000/0/0 where the first four-digits 
represent the invoice number, the second set of digits represents the job or job 
charges and the last digits represent the steps in the process. 

Description The textual information for the job as set up in the Estimate/Invoice. 

Status Current Status of the job. Possible Status settings: Active, Completed, Canceled. 

Facility The name of the facility where the production step took place.  

Station The computer terminal where data for the job is being entered.  

Location Where the job step is being completed or was completed. 

Employee The name of the employee who is working on the Active Item or worked on the 
Completed Item. 

Completed Only displayed for completed items, the Completed field displays the date and time 
that the Stop Tracker Step occurred. 

Exception code Only displayed for completed items, the Exception Code is set in the Stop Tracker 
Step window and is a quick explanation of a problem that occurred during the 
production process. 

Total time The Total Estimated and Total Actual time are displayed. 

Setup The Estimated and Actual time required to complete setup for the job. 

Run time The Estimated and Actual time to run the main process of the job. 

Washup The Estimated and Actual time to complete washup for an item. 

Ordered The total number of pieces ordered versus the actual number of pieces produced. 

Impressions The Estimated number of impressions versus the Actual number of impressions. 

Spoilage The Estimated spoilage for a job versus the Actual spoilage that occurred in the 
production process. 

Stock Cost The Stock Cost is only displayed in the Estimated column. This is the base cost 
without Markup as seen in the Production Data window. 

Labor Cost The Labor Cost is only displayed in the Estimated column. This is the base cost 
without Markup as seen in the Production Data window. 

Cost The Cost displayed in the Estimated column is the Stock Cost added to Labor Cost 
before Markup. The Cost in the Actual column has been recalculated based on data 
collection from the Tracker module. 

  

 
Page 93 

 



EFI PrintSmith 8.0 │ Tracker Module Instructions 

 

Stop Tracker Step 
The Stop Tracker Step window opens when the Stop icon is activated in the Active Items 
tab of the Tracker Console. The Stop Tracker Step window is similar to the Tracker Details 
window in some of the information that is displayed, but it is more powerful and interactive. 
In the Stop Tracker Step window you can view the Estimated versus Actual Time and 
Materials Costs, make adjustments to the Actual Time and Cost information depending on 
your user permissions, set Exception Codes to quickly note any problems that occurred 
during the production process, mark the step complete in the routing list and move it on to 
the next location in the routing, mark the invoice ready for pickup, and calculate spoilage. 

Stop Tracker Step Window 

 

Mark the step 
complete in the 
routing list and 
move the job into 
the next 
production 
location. 

Select an 
Exception code to 

explain any 
problems that 

occurred during 
the production 

process. Quickly calculate 
spoilage. 

Override Actual 
Costs with 

Estimated Cost 
information or 

manually update 
Actual data. 

Select this option 
to add Stop 

Tracker Step notes 
to job ticket notes. 
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General Item Information 
General information about the item is displayed at the top of the Stop Tracker Step 
window: the Item number, Description, the Facility name or physical building where the 
step was completed, the Station or computer terminal where data collection took place, 
the name of the Employee who completed the step, and the Production Location where 
the step was completed. 

Location and Step Information 
The Location field in the Stop Tracker Step window shows you where the current step 
was completed. If Production Locations have been set up in the Production Location table, 
this field will always be populated. Selecting the Mark step complete in routing list 
option will mark the step complete in the Tracker Production Window and in the Routings 
tab of the Tracker Status window. 

If you have a routing set up and assigned to the item, the Next Location field will also be 
populated with Production Location that the step will move to next. Selecting the Move to 
this Non-Production step option will automatically move the job to the next non-
production location. A Non-Production Location is a holding location, such as Staged Print 
or Staged Bindery. 

Exception Codes 
If Exception Codes are entered in the Production Exception table the employee will be 
able to select an exception code from the drop-down menu to quickly and easily explain 
any problems that might have occurred during this production step. Exception codes are 
customizable to your facility and should be used as standard exception reasons, for 
example: static in paper, bad plate. The Exception Code field allows for a quick and 
uniform way to gather information from production personnel without requiring a hand-
typed note. It will also assist employees who do not have the ability to override cost and 
time information to explain time discrepancies in the production process. 

Non-Production Locations and Exception Codes 

 

Select an 
Exception code 
from the drop-
down menu to 

note any 
production 
problems. 

The Next Location 
will display if a 

routing was 
assigned to the 

job. 

Select this 
option if the 
step should 
be marked 
complete in 

Select this 
option if the 
next step is 
non-
production. 
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Estimated and Actual Cost Information 
The Estimated and Actual Cost Information displayed in the Stop Tracker Step window is 
the same as displayed in the Tracker Details window, except that the Impression and 
Spoilage information is editable and employees with the appropriate permissions can 
override the actual cost data collected. 

Treat as Non-Production step 

Select the option Treat as Non-Production step, no cost if no cost should be calculated for 
this step. Possible non-production steps that would not incur a cost might be Proof, 
Completed-drying, Staged – Copying. When the Treat as Non-Production step, no cost 
option is selected, all cost information in the Stop Tracker Step is hidden. 

Treat as Non-Production stop, no cost option 

 

When this 
option is 

selected, all 
cost information 

is hidden.

 

Note: When a stop step occurs, the stock’s On Hand quantity (Inventory tab of the 
Stock Definition) is reduced by the number of sheets actually used (including 
spoilage). The Committed quantity is reduced by the original amount committed. 
The actual quantity used may differ from the committed quantity if the actual 
spoilage differs from the projected waste initially associated with the job.  

 

 
Page 96 



Tracker Console 

 
Employee Allowed to Override Costs 

Cost information is editable in the Stop Tracker Step window if the employee has 
permission to override costs. Permission to override costs is set in the Personal tab of the 
Employee window. 

For employees with the ability to override costs, there are two options for changing Actual 
Cost information.  

1. Update Actual Cost with Estimated Costs: If the employee selects the Fill  
Icon between the Estimated and Actuals columns, the Actuals column will be 
populated with the Estimated data. 

2. Manually Update Actual Costs: The employee can select the Actuals time fields for 
Setup, Run time, and Washup and type in the time. 

Overriding Actual Costs 

 

Select the Fill 
icon to override 

Actual Costs 
with Estimated 

Costs. 
Manually 
override actual 
cost information 
by selecting the 
field and typing 
in a new time. 

 

Employee Not Allowed to Override Costs 

If an employee does not have permission to override costs, as set in the Personal tab of 
the Employee window, the Fill icon will not be selectable and the Actual cost fields will not 
be editable. The employee will be able to set spoilage information. 

 

Notes:  Only those employees with the Allowed to override costs option selected in the 
Personal tab of the Employees window will be able to change cost information in 
the Stop Tracker Step window. 
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Spoilage Calculator 
A Spoilage Calculator has been included in the Stop Tracker Step Window to allow 
employees to easily calculate the spoilage for a job. To use the Spoilage Calculator, enter 
the Start number of sheets, then click Enter or tab to the End field and enter the End 
number of good impressions. Click Enter again, and the Difference will display. The 
Difference is the Start number minus the End number. The Difference is displayed as a 
negative number. This number can then be entered in the Spoilage field of the Actuals 
column. This will clear the data in the Start, End, and Difference fields of the Spoilage 
Calculator, and the Spoilage field will display the entered number. 

Spoilage Calculator 

 

Enter the Start 
and End 

The Difference is 
calculated for you. 

 

Spoilage Entered in Actuals 

 

The entered 
Spoilage is 
displayed and 
the other 
fields are 
cleared. 

Enter the 
calculated 

Difference in the 
Spoilage field.

 

Notes 
A Notes field is provided in the Stop Tracker Step window. Any Notes entered during the 
production process in the Tracker Details window can be viewed here as well. Select the 
Append notes to job tickets notes option if you want these production notes included on 
the Job Ticket. 
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Closing and Saving 
After all routing, cost, spoilage, and notes have been entered in the Stop Tracker Step 
window, save the information and close the window by clicking OK. Tracker Detail 
information can still be accessed about the job by selecting the item in the Completed 
Items tab of the Tracker Details window. 

If a routing was assigned to the item in the Tracker Production window, and this is not the 
last step in the routing, the job will move to the next Production Location. 

If a routing was assigned to the item in the Tracker Production window, and this is the last 
step of the routing and the Mark INV ready for pickup option was selected in the Routing 
Setup tab of the Tracker Manager for this step, when the employee clicks OK to close and 
save the Stop Tracker Step Window, a message will appear asking for confirmation that 
the invoice should be marked complete. 

Confirm marking invoice complete 

 

 

Stop Tracker Step Definitions 

Field Definition 
  

Item A reference number for the job displayed as 0000/0/0 where the first four-digits 
represent the invoice number, the second set of digits represents the job or job 
charge and the last digits represent the steps in the process. 

Description The textual information for the job as set up in the Estimate/Invoice. 

Facility The name of the facility where the production step took place.  

Station The computer terminal where data for the job is entered.  

Employee The name of the employee who is working on the Active Item or worked on the 
Completed Item. 

Location Where the job step is being completed or was completed. 

Next Location The Production Location that the job should move to next in the production process 
if a routing has been assigned. 

Exception code A quick explanation of a problem that occurred during the production process as set 
in the Production Exceptions table. 
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Field Definition 
  

Mark step complete 
in routing list 

Select this option if you want the step to be marked complete in the Tracker 
Production window and in the Routings tab of the Tracker Status window. 

Move to this Non-
Production step 

Select this option to move the job to its Next Location, which is a Non-Production 
step. 

Treat as Non-
Production step, no 
cost 

Select this option for production steps which do not have a cost assigned to them, 
such as Proof, Completed – Drying, Staged – Copy. 

Total time The Total Estimated and Total Actual time are displayed. 

Setup The Estimated and Actual time required to complete setup for the job. 

Run time The Estimated and Actual time to run the main process of the job. 

Washup The Estimated and Actual time to complete washup for an item. 

Ordered The total number of pieces ordered versus the actual number of pieces produced. 

Impressions The Estimated number of impressions versus the Actual number of impressions. 

Spoilage The Estimated spoilage for a job versus the Actual spoilage that occurred in the 
production process. 

Bindery Waste Waste information for bindery production steps. 

Stock Cost The Stock Cost is only displayed in the Estimated column. This is the base cost 
without Markup as seen in the Production Data window. 

Labor Cost The Labor Cost is only displayed in the Estimated column. This is the base cost 
without Markup as seen in the Production Data window. 

Cost The Cost displayed in the Estimated column is the Stock Cost added to Labor Cost 
before Markup. The Cost in the Actual column has been recalculated based on data 
collection from the Tracker module. 

Spoilage Calculator 
– Start 

The number of sheets run for a job. 

Spoilage Calculator - 
End 

The number of good impressions at the end of the production process. 

Spoilage Calculator 
– Difference 

Start – End = Difference. The calculated spoilage number. 

Spoilage Calculator - 
Spoilage 

Displays the spoilage number that is entered in the Actuals column. 
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Tracker Status Window 
The Tracker Status window, accessed by selecting Invoice > Tracker Status when an 
Invoice is open, is a management tool that displays Tracker information that has been 
collected for an individual invoice. In the header section of the window you can release the 
job to production. The total estimated time and total actual time for the job as well as the 
job’s current status are displayed in the window header as well. The History tab of the 
Tracker Status window displays the job’s Status, Item number, job description, production 
location, facility where the job is being processed, employee who is currently on the listed 
process, estimated and actual times for individual job steps, completion dates, and costing 
information. The Routings tab of the Tracker Status window displays the completion 
status, the item number, the production location, the facility, and the estimated run date.  

Tracker Status Window 

 

 

Release the 
job to 

production so 
that it can be 
started in the 

Tracker 
Console. 

View 
Historical 

data collected 
for the 

invoice and 
see the 

assigned 
Routings. 

View the 
Current Status 
of the Invoice:  
Not Started, 
Active, or 
Complete. 

Refresh 
the window 
to get the 
most 
current 
production 

Release to Production 

From within the Tracker Status window you can release a job to production. Releasing a 
job to production makes it available for selection in the Tracker Console, so processes can 
be timed. Jobs can also be released to production from the Tracker Production window. 

Total estimated time 

The Total estimated time field allows you to see the estimated time value for all items in 
the invoice. 

Total actual time 

After the item has been released to production and Tracker data has been collected, you 
can view the actual time that it took to complete the item. Comparing the Actual and 
Estimated times allows for more accurate estimates in the future. 
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Current Status 

The Current Status field displays Not Started, Active, or Completed, giving you a quick 
view of the invoices state in the production process, and letting you know if any action 
needs to be taken. 

History Tab 
The History tab of the Tracker Status window allows you to view the historical data 
collection information for invoices that have been completed, and also shows you 
information about the job while it is active in the Tracker Production process. 

History tab 

 

Icons in the 
Status column 

give you a quick 
visual clue of 

the item’s 
current status. 

View 
calculated 
costs and 
completion 
dates. 

Status Icons 

Icons in the Status column give you a quick visual clue of the item listing status and other 
information important to the item including: Notes, Started, Cancelled, Completed, 
Paused, and Exception Codes. 

  The exclamation point icon indicates that Notes have been included for the item. 

  The Start icon, which is used in the Tracker Console, indicates that the item has been 
started and is Active in the production process. 

  The Cancel icon, which is used in the Tracker Console, indicates that the item was 
cancelled during the production process. 

  The check mark indicates that this item was processed through the Stop Tracker Step 
and is complete. 

 The blue diamond indicates that an Exception Code was entered for the item at the 
Stop Tracker Step. 

 The Pause icon, which is used in the Tracker Console, indicates that the item has been 
paused during the production process. 
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Sorting Columns in the Tracker Status History 

Items in the History tab of the Tracker Status window can be sorted by each of the column 
headings: Status, Item, Description, Location, Facility, Employee, Estimated, Actual, Date 
Completed, and Costing. To sort the Active Items by information in a column, click on the 
column header. 

Refreshing the Tracker Status History 

When you open the History tab of the Tracker Status window, information displayed is 
current as of the time the window was opened. But, production data is always changing 
and to receive the most up to date information, you can refresh the information in the 
window by clicking the Refresh button in the lower left corner of the window.  

Accessing the Tracker Details Window 

Double-click on an item in the History tab to open the Tracker Details window and see 
more information regarding Estimated versus Actual time and costs for any job, if your 
settings in the Personal Tab of the Employee Window allow it. Notes can also be added in 
the Tracker Details window. For additional information on the Tracker Details window, 
please see the Tracker Details section of this manual. 

History Tab Definitions 

Column Name Definition 
  

Status This column displays icons that give you a quick view of the item’s status including: 
Notes, Started (Active), Completed, Cancelled, Paused, Exception Codes. 

Item A reference number for the job displayed as 0000/0/0 where the first four-digits 
represent the job number, the second set of digits represents the process part of the 
job, and the last digits represent the steps in the process. 

Description The textual information for the job as set up in the Estimate/Invoice. 

Location Where the job step is being or was completed. 

Facility The name of the facility where the production step is taking place. 

Employee The name of the employee who is working on the job or job step in production. 

Estimated The time estimate for overall job and/or item completion, depending on how you 
have your time estimates set. 

Actual The actual time it took to complete the item in the production process as recorded in 
the Tracker Console. 

Date Complete The date and time the Stop Tracker Step occurred and the item was completed. 

Costing If costing has been set up for the Tracker module, this column displays the Actual 
Time and Material cost based on calculations from Tracker data. 
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Routings Tab 
The Routings tab contains a snapshot view of the Routing that has been assigned to the 
job, the Estimated Run Date for the job based on the Routing Schedule, and once the job 
is Active, the steps that have been completed in the production process.  

Tracker Status Routings tab 

 

 

Notes:  If the routing assigned to a job has Schedule settings, either based on ordered 
date or wanted by date, a preliminary or estimated Run Date is assigned to the 
job. It is possible, however, to edit the Run Date through the Tracker Production 
window. 

Routings Tab Definitions 

Column Name Definition 
  

Complete If in the Stop Tracker Step window, the option Mark step complete in routing list 
is checked, an X will appear in the Complete column to indicate that this step of the 
routing is complete. 

Item A reference number for the job displayed as 0000/0/0 where the first four-digits 
represent the job number, the second set of digits represents the process part of the 
job, and the last digits represent the steps in the process. 

Location Where the job step is being completed. Supported by the Production Location table. 

Facility The name of the facility where the production step is taking place.  

Est. Run Date The Estimated Run Date is the calculated Run Date based on the Ordered Date or 
the Wanted By Date, and the Schedule settings in the Routing Setup tab of the 
Tracker Manager. 

  

The Est. Run 
Date is based 
on the Routing 
Schedule. 

The Stop Tracker 
Step was activated 

for these steps of 
the routing. 

The Production 
Location where 
the routing step 
was completed. 
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Using the Tracker Module: Supervisor 
The Tracker module provides powerful functionality that not only allows you to collect data 
that will help you better estimate costs, but also helps supervisors better manage the flow 
of work through the production facility, have quick access to the overall status of jobs, 
view detailed information about an individual invoice, and get a better idea of employee 
and machine productivity. 

Once the Tracker module has been set up with new tables and fields, costing has been 
determined, routings have been created, and employees with production filters have been 
entered, you will have access to the full functionality of the Tracker module. But, it is 
possible to implement the Tracker module in phases so that you can start experiencing 
the benefits of the Tracker module today. 

This section of the manual provides you with Tracker module information more specific to 
your role as a supervisor or manager, but additional details about windows, icons, and 
functionality can be found throughout the manual. 

Management Features of the Tracker Module: 

• Get an overview of all active items in production 

• Assign Routings to jobs to improve the flow of work through your facility 

• Analyze Tracker data using reports 

• Know the Actual cost of jobs to make better estimates in the future 

• Calculate your Actual Profit Margin 

• View the Tracker Status and History for individual invoices 

 

The Tracker Manager 
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Setting up Your Employee Profile 
You may be responsible for setting up your employees’ profiles in the Tracker module, but 
you also want to make sure that your profile is set to maximize the Tracker management 
tools. Settings in the Personal tab and Production Filter tab give you the access rights and 
views you need to better manage your department or facility. 

Once you have set up your employee profile, it is possible to edit it from the Tracker 
Console. Make sure your System Administrator has set up your login to allow this flexible 
option. To edit your employee profile, click on the icon next to the Employee name field. 
The Employee window with your profile and information will open with the Production 
Filter tab active. 

Accessing the Employee Profile from the Tracker Console 

 

Click the people 
icon to open the 
Employee 
window and 
make changes 
to your 
Production 
Filter.Personal Settings 

You will want to pay particular attention to your settings in the Editable Production Options 
of the Personal tab of the Employee window. 

Allowed to override costs: If you need the ability to alter the cost information collected in 
the Tracker module, make sure you have this option selected. This will allow you to 
override costs at the Stop Tracker Step. 

Allow to modify production settings: If part of your management role includes releasing 
jobs to production, scheduling routings, or making production setting changes in the 
Tracker Production window, make sure you have this option selected. 

Hide costing amounts, items not released to production, estimated time in Tracker 
Console: You will most likely NOT want to have these options selected. 

Editable Production Options 
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Production Filter 
The Production Filter tab of the Employee window allows you to customize your view of 
the Tracker Console. While you will want to limit your employees’ view to only include 
those items that they will be working on, in your management role, you may want a view of 
all active items in your department or facility. 

Example Production Filter for a Facility Manager 

 

Include all 
Jobs, Job 
Charges, 

and 
Invoice 

level 
Charges. 

Don’t limit 
your view 
to 
Production 
Parents. 

View all 
Pricing 

Methods 
and 

Charge 
Types. 

View all 
Customer 
wanted by 
dates. 

View all 
machines 

in your 
facility. 
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You should consider the following when setting your Production Filter: 

Include 
You will want to include Invoice Jobs or Estimate Jobs based on your version of 
PrintSmith. You may also want to include Job Charges and Invoices level charges 
depending on the level of detail you want displayed in the Tracker Console. 

Customer wanted by 
This is an option that you may change frequently. On particularly busy days, you may only 
want to view those items Due Today. But, to get a better overall view, as a default you 
may want to have the Due Anytime and Any past due options selected. 

Production Parents 
You will most likely not want to have any production parents set, unless you are managing 
a particular department and want to view those items that will be coming to your 
production staff next. 

Pricing Methods 
If you are a facility manager, you may want to select the Use all Pricing Methods option. If 
you manage one department, you will only want to see the Pricing Methods that apply to 
your department. For example, if you are a Printing Foreman, you might only want to 
select the Printing pricing method option. 

Charge Types 
If you are a facility manager, you may want to select the Use all Charge Types option. If 
you manage Bindery operations, you may only want to select the Bindery charge type. 

Presses 
If you are a facility manager or printing foreman, you will probably want to select the Use 
all Presses option. If you do not manage any press work, you will most likely not need to 
select anything for this option. 

Copiers 
If you are a facility manager or manage copying, you will probably want to select the Use 
all Copiers option. If you do not manage any copy work, you will most likely not need to 
select anything for this option. 

Releasing a Job to Production 
The powers of Tracker data collection, begins with you – the Supervisor or Manager – 
when you release a job to production. Depending on the invoicing and ordering 
responsibilities in your facility, there are two ways to release a job to production, through 
the Tracker Status window or through the Tracker Production window. The difference 
between releasing a job to production from the Tracker Status window and the Tracker 
Production window is that within the Tracker Production window, a routing can also be 
assigned. 
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Releasing an Invoice to Production through the Tracker Status 
Window 
1. Open the invoice that you want to release to production. 

2. Go to Invoice > Tracker Status to open the Tracker Status window. 

3. Select the Release to production option in the top left corner of the window. 

4. Close the Tracker Status window and save the change to the invoice by clicking the 
File icon. 

5. The invoice has now been released to production and is ready to have a routing 
assigned and be started in the Tracker Console. 

Releasing an Invoice to Production through the Tracker 
Production Window 
1. Open the Tracker Production window: 

a. Double-click on an item in the Active Item Listing of the Tracker Console. 

b. Select the Tracker Production command from the Job window for an 
Invoice. 

2. Select the Release to production option in the top of the window. 

3. Click the File icon to save the change and close the Tracker Production window, or 
make additional changes in the Tracker Production window before closing. 

4. The invoice has now been released to production and can be started in the Tracker 
Console. 

Release to production in Tracker Production window 

 

Notes:  Unreleased invoices are viewable in the Tracker Console depending on your 
employee profile settings. Unreleased invoices appear with a strikethrough in the 
Active Items listing. Once the invoice has been released, the strikethrough is 
removed. 
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Assigning a Routing to a Job 
Routings that were created in the Routing Setup tab of the Tracker Manager can be 
assigned to an invoice in the Tracker Production window. Assigning a routing will allow 
you to follow the progress of the item through the production process, see which steps are 
complete and which still need to be finished. It will also help your employees to manage 
their workload and better track the time spent on different processes. 

Tracker Production Window 

 

Select a routing 
from the drop-

down menu

Re-order steps 
using drag and 

drop Remove steps 

Click here to 
add new steps 

to the routing

Select one step 
or a range of 

steps and bump 
the Run Date 

ahead or back 
one day at a 

time

Change the 
Production 
Location 

Sort routing steps 
by their run date 

Set a Priority 

 

 

Notes:  For additional information on setting up routings, please see the Routing Setup 
section of this manual. For additional information on the Tracker Production 
window, please see the Tracker Production Window section of this manual. 
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Assigning a routing to a job is quite simple in the Tracker Production window. To assign a 
routing: 

1. Open the Tracker Production window: 

a. Double-click on an item in the Active Item Listing of the Tracker Console. 

b. Select the Tracker Production command from the Job window for an 
Invoice. 

2. Select a pre-configured routing template from the drop-down menu. 

3. Customize the routing to best fit the invoice: 

a. Add New steps: Click the New Step button to add new steps to the routing. 
Set the Facility, Location, a Run Date, and Run Time. 

b. Remove steps: There are two ways to remove a step from a routing. 

i. Remove button: Select the step that you would like to remove and 
click the Remove button. The routing step will be deleted from the 
list. 

ii. X: Select the step that you would like to remove and click the 
mouse in the X column. The Run Date and Run Time will be 
removed from the step, but it will still be visible in the routing list. 

c. Re-arrange the routing order: 

i. Drag and Drop: Select any step in the routing and drag it where you 
would like it to be in the routing order. 

ii. Sort by run date: Click the Sort by run date button and the steps 
will be ordered by the date they are set to run. 

d. Change the Facility and Production Location: Select the step you would 
like to edit and select a different Facility or a different Production Location 
from the drop-down menu. 

e. Set a Priority: Select a Priority from the drop-down menu. 

4. Click the File icon to save and close the Tracker Production window. 

 

Notes:  Routings that are set up in the Routing Setup tab of the Tracker manager are 
templates. Routings can be customized in the Tracker Production window, but 
this will not affect the saved routing template. 

Managing Items in the Tracker Production Process 
The Tracker module provides management tools that allow you to get an overview of the 
production process, or drill-down to an individual invoice level. You can access Tracker 
information while the invoice is still in production or after the production process has been 
completed. 
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Viewing all Active Items in the Tracker Manager 
Use the Active Items tab in the Tracker Manager to get a quick overview of all items that 
are currently active. You can filter this view in the Preference tab to only see the active 
items you need to see based on your management role. Active Items can be filtered by 
Facility and Station in the Preference tab. You can drill-down to an individual invoice level 
by double-clicking on any line item in the Active Items tab to view the Tracker Details for 
that item. 

Active Items Tab 

 

Click the 
Refresh 

button to 
display the 

most 
current 

information

Status 
icons give 

you 
additional 

information 
about the

Sort Active Item 
information by 
clicking on any 
column header. 

(8 of 10) shows 
that you are 
viewing 8 of the 
total 10 Active 
Items 

 

Tracker Reports 
Production reports and employee reports are available in the Tools tab of the Tracker 
Manager to help you analyze the data collected in the Tracker Console. 
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Viewing the Tracker Status for an Invoice 
Sometimes you need an overview of the processes in your facility or department, and 
sometimes you need specific information about a particular invoice. The Tracker Status 
window provides you with a convenient interface to give you the information you need at a 
glance. You can: 

• View Historical data collection information 

• See the Current Status 

• Compare Estimated and Actual Times 

• Find where an invoice is in the production process 

Tracker Status Window 

 

Compare 
Estimated and 

Actual time Current 
Status 

Double-click on 
any line item to 

view Tracker 
Details 

View historical 
Tracker data 

See where the 
invoice is at in 
production by 
viewing the 
Routings tab 

Invoice Costing Information 
If you defined Time and Materials costing in the Charge Definitions window, you will be 
able to utilize the Data Collections feature in the Invoice Costing window. Beyond 
comparing Estimated and Actual Times, you will also be able to compare Estimated and 
Actual Costs. The monetary and percentage Difference in cost is calculated for you, as 
well as your margin of profit. 

Invoice Costing – Estimate and Actual Costs Compared 

 

Actual 
Cost is 

calculated 
with Time 

and 
Material 

Costs 
defined 

Profit 
Margin 
based on 
Actual 
Cost 
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Using the Tracker Module: General User 
The Tracker Console is a PrintSmith module that allows for production data collection to 
better estimate jobs and ensure profitability. Your role in the data collection process is vital 
as it is the time you spend on your tasks that can impact the actual cost of a job. As you 
become more familiar with using the Tracker Console, it helps make your workflow 
smoother and more efficient. This section contains information on how to use the Tracker 
module. Additional information about windows, icons, and functions can be found 
throughout the manual. 

Accessing the Tracker Console 
To access the Tracker Console, select Admin > Tracker Console. 

The Tracker Console Window 

 

Select your name 
from the drop-

down menu 

A filtered list 
of Active 
Items, in your 
job queue, 
that you have 
not been 
started yet 

A display of 
Barcode entry 

information 

Select your 
Production 

Location from the 
drop-down menu 

Job Control 
icons allow 
you to time 
the 
production 
process 

The time bar is a 
graphical display 

of the time that 
has passed on job 
you’re working on 

A listing of the 
Active Items you 
currently have in 
production 

 
Page 114 



Using Tracker 

 

Tracker Console Login 
Your employee name should have been entered in the Tracker System, and you may 
have had a PIN assigned to you. For further details regarding your Tracker Console login 
and PIN, please ask your System Administrator. Once you have logged in, you will be able 
to see the invoices, estimates, due dates, production parents, pricing methods, charge 
types, presses, and copiers that were set for you in your employee profile. 

1. To display your Active Items in the Tracker Console, click in the Employee name field. 

2. A list of employee names appears. Double-click on your name to display your Active 
Items. 

Selecting the Employee Profile 

 

Select your 
name from the 
drop-down 
menu. 

 

3. If you are required to enter a PIN number, the Enter your PIN number window will 
appear when you select your name. 

4. You can enter your PIN using the keyboard, or by clicking on the disclosure triangle in 
the PIN number window to display the numerical touchpad which can be used with a 
touch screen monitor. 

PIN Entry Window 

 

Enter the PIN here 
using the keyboard. Click the disclosure 

triangle to display the 
numerical touchpad.

Notes:  If your facility uses magnetic card readers, simply swipe your card with the 
Tracker Console open to login. 
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Numerical Touchpad Window 

 

Your PIN is not displayed 
as it is entered. 

Large buttons allow for easy 
touch screen entry.

Click OK after you have 
entered your PIN. 

 

5. Click OK after you have entered your PIN number. If an incorrect PIN as been 
entered, a warning message will be displayed, and you will be returned to the Enter 
your PIN number dialog box to re-enter your PIN. You have three chances to enter 
your PIN number. If all chances are exhausted, you must re-select your name from 
the Employee drop-down menu. 

User Alert for Incorrect PIN entry 

 

Click OK and 
you will be 
returned to 
the PIN entry 
dialog box. 

 

Three Opportunities for PIN entry exhausted 

 

If all three 
PIN entry 
attempts 
have been 
exhausted, 
re-select your 
name to try 
again. 
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Employee View of the Tracker Console 
Once you have logged into the Tracker Console, your view of Active Items in the Active 
Items tab should be specific to your job functions as set by your Supervisor or the System 
Administrator. If you are not seeing your appropriate tasks or items in the Active Items 
listing, please contact your Supervisor or System Administrator. 

Active Items 
Most of your activity within the Tracker Console will involve the Active Items tab, which 
can be divided into seven sections: Employee login, Active Items listing, Current Station, 
Barcode Input, Job Control Icons, Tracker Time Bar, and the Employee Active Item 
Listing. 

Active Items tab 

 

Employee 
Login 

Active Items 
Listing 

Current 
Station

Barcode 
Input 

Job Control Icons 

Tracker 
Time Bar Employee Active 

Item Listing 

 

Employee Login: Where you select your employee name and enter a pin, if required, to 
access the Tracker Console. It is also possible to edit your employee profile from here if 
you have been granted rights to do this by your System Administrator. 

Active Items Listing: A list of all items actively in production which are filtered based on 
your production filter settings. Generally, you should only see items in the Active Item 
Listing that you are actively working on, or jobs that are coming to you next in the 
production process. 
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Current Station: You will want to check that in this area the correct Facility and Station 
name are displayed. You will also need to select the correct Production Location for the 
item you are working on. 

Barcode Input: If barcode scanners are used in your facility, the scanned information 
from Employee ID and Job Tickets will appear here. 

Job Control Icons: Use these icons/buttons to record the start, setup, washup and stop 
times for the job you are working on. 

Tracker Time Bar: A visual timer that allows you to see how much time has passed on 
the item selected in your Employee Active Items Listing. 

Employee Active Items Listing: This is the list of items that you are currently working on 
in the production process. 

Adjusting the Employee Production Filter 
It is possible to change your employee profile from the Tracker Console, if you have been 
granted rights to do so by your System Administrator. To edit your employee profile, click 
on the people icon next to the Employee name field. The Employee window with your 
profile and information will open with the Production Filter tab active. 

Accessing the Employee Profile from the Tracker Console 

 

Click the 
people icon 
to open the 
Employee 
window and 
make 
changes to 
your 
Production 
Filter. 

 

 

Make any necessary changes to your Production Filter, and then click the File icon to save 
changes and return to the Tracker Console. For more information on editing your profile 
please review the Entering Production Filter Information in the Employee Window section 
of this manual. 

Notes:  Please check with your System Administrator regarding your rights to edit your 
employee profile, or before making any changes to your employee profile. 

Production Parents 
Depending on the settings in your employee profile, you will see Production Parents 
displayed in the Active Items Listing. Production Parents are those jobs that are in the 
step before yours and will be coming to you next. For example, if you work with Bindery 
that would be your Production Location and your Production Parents might be jobs in the 
Press Production Location. 
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Production Parent Items are displayed in blue in the Active Items Listing. Once the 
Production Parent job is completed in the step before yours, it will still be displayed in 
blue, but the Active Location field will show that the step is done. Once you start the item 
at your Production Location, the item will be displayed in black and will also appear in your 
Employee Active Item Listing. Use the Refresh button to make sure you have the most up 
to date production information. 

Production Parents in the Active Items Listing 

 

Black items 
are active in 
your 
Production 
Location. 

Click the Refresh 
button to make 

sure you are 
viewing the most 

current information 

Blue Items are 
Production 

Parents, and will 
be coming to you 

next. When the 
Production 
Parent Active 
Location 
indicates 
“done”, you 
can start 
processing at 
your 
Production 
Location. 

 

Setting the Production Location 
Three fields of information are displayed in the Current Station area of the Active Items 
tab: Facility, Station Name, and Location. The Facility is the physical building you are 
working in. The Station Name is the name of the computer terminal where you are 
inputting data into the Tracker Console. The Facility and Station Name fields have already 
been set for you. If they are not correct, please contact your Supervisor or System 
Administrator. 

You will need to set the Location, which is the Production Location such as Prepress, 
Press, and Bindery, where you will be processing the item. Select the Location by clicking 
on the Location field and double-clicking your selection from the drop-down menu that 
appears. The selected Location will appear in the Active Location column of the Active 
Items Listing when the job is started. 

Setting the Production Location 

 

Select the Location by 
double-clicking on one 
of the options in the 
drop-down menu. 
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Using the Job Control Icons to Time the Job 
The job tracking control icons allow you to time job processes from start to finish. By 
pushing the Start icon at the beginning of a process and the Stop icon at the end of a 
process, the actual time for the process is recorded. Job tracking control icons are only 
active (selectable) when their selection is allowed. Inactive icons are visible, but faded. 

Job Control Icons – Quick Reference 

 

Start: Select the Start Icon to begin timing a job or job item. 

 

Setup Done: Select the Setup Done Icon when the initial setup for a job or job item 
is completed. This will record the setup time and start timing of the main process. 

 

Washup: Select the Washup icon when printing of a job is completed and the press 
is cleaned for the next job. This stops time on the main process and records time for 
the Washup. 

 

Finish Up: Select the Finish Up icon when a job charge is complete and the machine 
is prepared for the next job. Finish Up is similar to Washup, but is used for non-press 
jobs. 

 

Next Pass: For multi-pass jobs the Next Pass icon will appear in place of the Stop 
icon when the current pass has been completed and it is time to start the next pass. 
After the completion of the last pass, the Stop icon will appear to stop the time for the 
entire job. 

 

Stop: Select the Stop Icon when all steps in the job have been completed. The timer 
is stopped for the job. Selecting the Stop icon opens the Stop Tracker Step window. 

 

Cancel: Select the Cancel Icon if your job is interrupted or falsely started to stop the 
timer and remove any recorded times. A warning message will appear if the Cancel 
Icon is selected to confirm that the process should be canceled. 

 

Pause: Select the Pause Icon if you need to step away from a process and are not 
actively working on it. This will stop the timer, but not cancel the job, so that an 
accurate time will be recorded for the process. 

 

Continue: The Continue icon is only available if the Pause Icon has been selected. 
Click the Continue Icon to have the time continue recording time after your job has 
been paused. 

 

Open: Select the Open icon to open the Invoice or Estimate window. 

 

Job Ticket: Select the Job Ticket icon to open the Job Ticket window. 

 

Cutout: Select the Cutout icon to open the Cut Diagram window. 
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Timing the Job 
When the item is in your production queue, but in the step before yours, it is displayed in 
blue. This is based on your Production Parent settings. You can see which Production 
Location and step of the routing it is in by viewing the Active Location column. 

When the item is ready for you to begin processing, it will be displayed in black if you do 
not have Production Parents set. If you do have Production Parents, the job will be 
displayed in blue, and the Active Location column will display (done) to indicate the 
previous step is complete and you can begin processing.  

Active Location Done 

 

(done) in the 
Active Location 
means that the 
parent step is 
complete and you 
can begin 
processing. 

The Start icon 
appears next to items 

that are currently 
active. 

 

To begin processing: 

1. Make sure you have your Location selected in the Current Station area of the Tracker 
Console. 

2. Select the Item in the Active Item Listing and click the Start  icon. Timing will 
begin on the item, and it will appear in the Employee Active Item Listing at the bottom 
of Tracker Console. Only the Items that you are currently working on will appear in 
the Employee Active Item Listing. Begin your regular set up steps for the job. 

Started item in Employee Active Item Listing 
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3. When you finish setting up for the job, click the Setup Done  icon. Timing will 
continue on the job, but a blue triangle will appear at the bottom of the Tracker Time 
Bar to mark when you completed setup. 

Setup Done in Time Bar 

 

A blue triangle appears at 
the bottom of the Tracker 
Time Bar when Setup 
Done is selected. 

Estimated Setup 
Time is displayed in 

green.

4. Continue with your regular production work. You will not need to access the Tracker 
Console again until you are nearing the end of the process, unless you need to 
Pause or Cancel the item. Or, unless you would like to view the Job Ticket or 
Cutout, Open the invoice, or enter Notes through the Tracker Details window. 

5. Click the Washup  icon or Finish Up  icon, when the main process of the 
job is complete and you are ready to start the washup or finish up steps. A red 
triangle will appear at the bottom of the Tracker Time Bar to mark the end of the main 
process and the beginning of the Washup or Finish Up. 

Washup Done in Time Bar 

 

A red triangle appears at 
the bottom of the Tracker 
Time Bar when Washup 
or Finish Up is selected. 

Estimated Production 
Time is displayed in blue.

6. When you have finished the Washup or Finish Up, click the Stop  icon. Timing 
will be stopped on the item and the Stop Tracker Step window opens. 

 

Notes:  These instructions assume that you will be using a computer terminal to enter the 
Tracker data to time the job, but it is possible that your facility may use touch 
screen or barcode scanner technology. If your facility uses touch screen 
monitors, you can select your Active Items and use the Job Control icons by 
simply touching the screen. If your facility uses barcode scanners, you will be 
provided with a printout of Job Charges and equivalent barcodes, which you can 
scan at the beginning and end of each stage of the process. 
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Viewing Tracker Details for the Job 
You can view data collection information about Active and Completed Items in the Tracker 
Details window. You can see the Status, the Facility where the item was completed, the 
workstation where data collection occurred, the Production Location where the item was 
completed or is in progress, your Employee name, the Completion Date and Exception 
Codes for Completed Items, Estimated versus Actual Time and Cost information, and any 
Notes. Information available in the Tracker Details will vary based on its status in the 
production process, the access rights to costing information, and whether or not it is a 
single or multi-pass job. 

Tracker Details Window 

 

Item Identification 

Physical and 
Production Location 

Information 

Estimated and Actual 
Time Information 

The 
Actuals 
shows the 
time you 
recorded in 
the Tracker 
Console 

Cost information will 
not be displayed 

unless your access 
rights permit it 

Enter 
Notes here 

Click OK to close the 
Tracker Details 

window and save any 
notes 
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Accessing the Tracker Details Window 
The Tracker Details window can be accessed in several ways: 

• From the Employee Active Item Listing – double-click on the selected item. 

• From the Tracker Time Bar – with the item selected in the Employee Active Item 
Listing, double-click on the Tracker Time Bar. 

• From the Completed Items tab – double-click on the selected item. 

Entering Notes 
A Notes field is provided in the Tracker Details window. This allows you to add notes to 
the job that will be recorded and saved with the item. You can also enter notes about any 
problems that occurred during the production process, but you may want to do this using 
the Exception Codes in the Stop Tracker Step window, if they have been implemented for 
your facility. Any Notes entered during the production process in the Stop Tracker Step 
window can be viewed here as well.  

Stop Tracker Step 
When the setup, main process, and washup or finish up of the item you are working on is 
complete, you will select the Stop icon to stop all timing for the job or job charge. Clicking 
the Stop icon opens the Stop Tracker Step window. Here you can view the Estimated 
versus Actual Time and Materials Costs, and make adjustments to the Actual Time and 
Cost information if your user permissions allow it. You can also set Exception Codes to 
quickly note any problems that occurred during the production process, mark the step 
complete in the routing list and move it onto the next location in the routing or mark the 
invoice ready for pickup, and calculate spoilage. 
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Stop Tracker Step Window 

 

Mark the step 
complete in the 
routing list and 
move the job into 
the next 
production 
location. 

Override Actual 
Costs with 

Estimated Costs if 
your permissions 

allow it. 

Exception codes 
let you quickly 

explain any 
problems that 

occurred during 
the production 

process. Quickly calculate 
spoilage. 

Notes entered in 
Tracker Details will 

be displayed and 
additional notes 
can be entered. 

 

Depending on your user permissions and the item, you may need to update the following 
information, in the Stop Tracker Step window: Mark step complete, Exception code, Non-
Production step, Actual times, Notes, Impressions and Spoilage. 
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Mark step complete in routing list 
Select the Mark step complete in routing list option to mark the step complete in the 
Tracker Production window and in the Routings tab of the Tracker Status window, which 
will be viewed by your supervisor or manager. It will also let the person in the production 
step after yours know that they can begin processing. 

Exception code 
Select an exception code from the drop-down menu to quickly and easily explain any 
problems that might have occurred during the production step. Exception codes are 
customizable to your facility but will be standard exception reasons, for example: static in 
paper, bad plate. Additional Notes can be entered if an applicable Exception Code does 
not exist, or if you wish to provide additional details. 

Treat as Non-Production step, no cost 
Select the option, Treat as Non-Production step, no cost if no cost should be calculated 
for this step. Possible non-production steps that would not incur a cost might be Proof, 
Completed-drying, and Staged – Copying. When the Treat as Non-Production step, no 
cost option is selected, all cost information in the Stop Tracker Step is hidden. 

Override Actual Times 
If you have permission to override costs, there are two options for changing Actual Cost 
information.  

1. Update Actual Cost with Estimated Costs: Select the Fill  Icon between the 
Estimated and Actuals columns and the Actuals column will be populated with the 
Estimated data. 

2. Manually Update: Select the Actuals time fields for Setup, Run time, and Washup and 
type in the correct time. 

Notes 
A Notes field is provided in the Stop Tracker Step window. Any Notes entered during the 
production process in the Tracker Details window can be viewed here as well. Select the 
Append notes to job tickets notes option if you want these production notes included on 
the Job Ticket. 

Impressions 
Enter the actual number of impressions or output from the production step when 
applicable. 
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Spoilage 
The Spoilage Calculator in the Stop Tracker Step window helps you to easily calculate the 
spoilage for a job. To use the Spoilage Calculator: 

1. Enter the Start number of sheets, then click Enter or tab to the End field. 

2. Enter the End number of good impressions. 

3. Click Enter again, and the Difference will display. The Difference is the Start number 
minus the End number. The Difference is displayed as a negative number. 

4. Enter this number in the Spoilage field of the Actuals column. The data in the Start, 
End, and Difference fields of the Spoilage Calculator will be cleared, and the Spoilage 
field will display the entered number. 

Spoilage Calculator 

 

Enter the Start and 
End numbers. 

The Difference is 
calculated for you. 

Viewing Completed Items 
The Completed Items tab is a temporary log of all items that have been completed at the 
Workstation. Once a job has had reached the Stop Tracker Step stage, it is removed from 
the Active Items tab listing, but you can still access the Tracker Details for the item in the 
Completed Items tab. The Completed Items tab is cleared when the Tracker Console is 
closed or when the PrintSmith application is exited. 

Completed Items Tab 

 

Sort 
Completed 
Item 
information 
by clicking on 
any column 
header. 

Click the 
Clear button 

to remove 
all items 
from the 

Completed 
Items tab.

The 
exclamation 
point next to 

an Item 
indicates 

Notes. 

Double-click 
on a line item 
to view 
Tracker 
Details. 
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